
RES Help Manual 

7001-31114-900    REV 06-18



Contents 
RES ...................................................................................................................................................................... 1 

Differences between RES and NeoVision .............................................................................................................. 1 

AutoSave History ........................................................................................................................................................... 1 

Email Delivery Service and Error Logging ...................................................................................................................... 3 

Look and Feel ................................................................................................................................................................ 4 

ASK (Advance System Key) ............................................................................................................................................ 5 

Global Common Differences ......................................................................................................................................... 5 

Global Conventional Differences .................................................................................................................................. 7 

Global Trunking Differences.......................................................................................................................................... 8 

Conventional System Differences ................................................................................................................................. 9 

Trunking System Differences ...................................................................................................................................... 10 

Zone Setting Differences ............................................................................................................................................. 11 

Channel Differences .................................................................................................................................................... 12 

Configuration Software ...................................................................................................................................... 13 

Title Bar ....................................................................................................................................................................... 13 

Menu Bar..................................................................................................................................................................... 13 

Tabs ............................................................................................................................................................................. 24 

Icon Bar ....................................................................................................................................................................... 25 

Icon Bar ................................................................................................................................................................... 25 

Menus ..................................................................................................................................................................... 29 

Buttons & Switches ................................................................................................................................................. 32 

Global ................................................................................................................................................................ 34 

Global - Common ........................................................................................................................................................ 34 

Common - General .................................................................................................................................................. 35 

Common - Keys ....................................................................................................................................................... 42 

Common - Dual Mode Scan .................................................................................................................................... 44 



Common - Voice/Mic Prefs ..................................................................................................................................... 45 

Common - PC Access Password .............................................................................................................................. 46 

Common - FSI Options ............................................................................................................................................ 49 

Global - Conventional.................................................................................................................................................. 50 

Conventional - General ........................................................................................................................................... 50 

Conventional - Features .......................................................................................................................................... 54 

Conventional - Keypad Edits Lockout ...................................................................................................................... 56 

Global - P25 Trunking .................................................................................................................................................. 57 

P25 Trunking - General ........................................................................................................................................... 57 

Menu and Function Buttons & Switches .................................................................................................................... 58 

Systems ............................................................................................................................................................. 60 

System - Conventional ................................................................................................................................................ 60 

Conventional System: General ................................................................................................................................ 61 

Conventional System: Unit ID Alias List .................................................................................................................. 67 

Conventional System: CxCSS Picklist ....................................................................................................................... 68 

Conventional System: NAC Picklist ......................................................................................................................... 69 

Conventional System: Talkgroup Picklist ................................................................................................................ 70 

Conventional System: Two Tone List ...................................................................................................................... 71 

Conventional System: DTMF List ............................................................................................................................ 72 

Conventional System: MDC List .............................................................................................................................. 73 

Conventional System: Five-Tone List ...................................................................................................................... 74 

Conventional System: User Status List .................................................................................................................... 75 

Conventional System: Text Messages ..................................................................................................................... 76 

Conventional System: Data/OTAR .......................................................................................................................... 77 

Conventional System: Phone .................................................................................................................................. 79 

System - P25 Trunking................................................................................................................................................. 80 

P25 Trunking - System Keys .................................................................................................................................... 80 

P25 Trunking - General ........................................................................................................................................... 81 



P25 Trunking - Channel IDs ..................................................................................................................................... 88 

P25 Trunking - Control Channels............................................................................................................................. 89 

P25 Trunking - Unit Calls ......................................................................................................................................... 90 

P25 Trunking - Talk Groups ..................................................................................................................................... 91 

P25 Trunking - Announcement Groups ................................................................................................................... 92 

P25 Trunking - Sites ................................................................................................................................................. 93 

P25 Trunking - Data/OTAR ...................................................................................................................................... 94 

P25 Trunking - Scan Lists ......................................................................................................................................... 98 

P25 Trunking - Preferred Site Lists ........................................................................................................................ 101 

P25 Trunking - Sentinel IDs ................................................................................................................................... 102 

P25 Trunking - User Status .................................................................................................................................... 103 

P25 Trunking - Short Msg Update ......................................................................................................................... 104 

P25 Trunking - Interconnect ................................................................................................................................. 105 

Max List Entries ......................................................................................................................................................... 106 

Zones & Channels ............................................................................................................................................ 107 

Multi-Channel View .................................................................................................................................................. 108 

Zone Settings ......................................................................................................................................................... 109 

Channels - Conventional ....................................................................................................................................... 112 

Channels - P25 Trunking........................................................................................................................................ 124 

Single Channel View .................................................................................................................................................. 127 

Zones Settings ....................................................................................................................................................... 128 

Channel Settings ................................................................................................................................................... 131 

Channels - Conventional ....................................................................................................................................... 132 

Channels - P25 Trunking........................................................................................................................................ 139 

Copy, Paste & Shortcuts ............................................................................................................................................ 141 

Radio Options Control/Feature Editing Software .............................................................................................. 143 

FAQ ................................................................................................................................................................. 144 



RES 

Res (Radio Editing Software) 

RES 
KNG Portable & Mobile 
Radio Configuration Editor 
from BK Technologies 

Differences between RES and NeoVision 

AutoSave History

RES has a new AutoSave feature which periodically saves your file in case one needs to go a few 
sessions back. The AutoSave window can be found under Utilities on the main page. 
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This feature saves up to 10 files.  The duration between each save can be adjusted. The user can 
open a previously saved file by selecting the file and clicking the Load Selected File button. 

AutoSave can be enabled under Options->Auto Save. 
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Email Delivery Service and Error Logging
Upon starting RES for the first time, a popup window will prompt the user to register.  This 
feature is used for bug reporting that may occur to improve and help minimize customer 
issues.   
When a bug occurs, an email will be generated with the error information and sent to the RES 
software support team.    

The registered email address can be changed under Help -> Change Registered Email. 

Contact Software Support will prompt the user to send an email to software support. 

The "Read and Package All Versions From Attached Radio" checkbox will automatically 
download information from the connected radio to help with debug requests. 
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Look and Feel  

  
RES allows the user to modify a few cosmetics to make the 
application more appealing based on individual preference.   
  
View Style Selection -  Changes the "Look and Feel" of RES.   
This option is found in the menu under View->View Style 
Selection. Note: The "Look and Feel" cannot be changed on 
Mac or OS X systems. 
  

 
  
  
Color Theme Selection - Changes the color scheme of RES.  
Currently supports 7 different color themes.  This option is found 
in the menu under View->Color Theme Selection. 
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ASK (Advance System Key)  

   
RES now supports importing of both Legacy Keys and ASKs via the standard RES build.  This 
means there is no separate ASK version of RES, but is rather built in the standard version. 
 Keys may be imported or cleared at any time.  Simply navigate to Tools->System Keys.  No 
options will be editable on foreign systems.   
If system keys are reset after creating a non RX-only system, the system will be denoted as 
foreign and no further changes can be made.   

 
  

 
 

 
 
Global Common Differences  

  
Various Global Common Options have been relocated from the "Other" sub-group in 
NeoVision to the Global Common Main Tab. 
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Options related to Voice and Mic have been moved to the Voice/Mic Preferences Window. This 
window can be accessed from the Global Common Main Tab. 
  

 
  
  
GPS features have been moved to the Main Tab under Global Common. 
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Global Conventional Differences  

The Options in the Features Tab located in NeoVision have been moved to the Global Conventional 
Tab in RES. 
 

 
  
  
The Keypad Editing Lockouts Tab has been moved to its own Window. 
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The Menus and Button Configuration Tabs have been moved to the Main Screen in the top right. 
The user is able to program both conventional and trunking. 
   

 
   

 

 
Global Trunking Differences  

  
The Menus and Button Configuration Tabs have been moved to the Main Screen. 
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Conventional System Differences  

  
The Encryption Tab has been moved to the Main Tab. 
  

 
  
All other tabs are now windows that can be opened. 
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Trunking System Differences  

  
Options in the "Other" sub group have been moved to the Additional Options Window. 
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Zone Setting Differences  

  
Zone selection is now in a combobox at the top of the tab. 
  

 
  
 +Z - Add new Zone 
  
-Z - Delete selected Zone 
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Channel Differences  

  
Some channel options from the "Other" sub group have been moved to the Zone Settings 
Window under Additional Options. 
  

 
  

 
  
  
  
+CC - adds a Conventional Channel 
  
+TC - adds a Trunking Channel 
  
++C - brings up a window to add\delete channels in one action based on indexes. 
  
-C - deletes currently selected channel 
  
M - displays the multi-channel editor. 
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Configuration Software 
 
RES is the configuration software for RELM Wireless' KNG APCO Project 25 digital radio product line. 
This product line supports Wide band and Narrow band Analog, P25 Digital Conventional and P25Trunking 
protocols. 
All RES files use the file extension ".neo". 

 

 

Title Bar  

RES's title bar displays the radio configuration file that is currently under review. 
Also displayed is RES's version information. 
  
  

 
 

 

Menu Bar  

The Menu bar provides the user with typical Windows functionality features. 
   

 
   
File Menu 
The File menu allows the user to manage RES programming files. 
  
  

 
  
  
New: 
Opens a new default file. 
  
Recent: 
Shows a list of recently loaded files to open into RES. 
  
Open: 
Opens a file from an archive directory. 
  
Save: 
Save changes to the active working file. 
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Save As: 
Saves and names the active working file. 

  
Info: 
Details the version of RES used to save the current file. 

 
  
Export: 
Exports all Global, System, Zone, and Channel data to an Excel ™ (.XLS) spreadsheet file. 

  
Import: 
Imports all Global, System, Zone, and Channel data from an Excel ™ (.XLS) spreadsheet file. 
  
Exit: 
Exits RES. 

  
  
  
Options Menu 
The Options menu allows communication with the radio. 

  

 
  
  
Radio Type: 
Selects the radio type [portable, mobile] for the active working file 
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Default Band: 
Sets the frequency band of the active working file. 
  

 
  

  
Auto Save: 
Automatically saves after a duration set by the user under Window -> Auto Save History. 
Auto-saving will only occur if the user is active for that duration. 

  
    Override Narrowbanding: 
    Allows Wideband operation. 
  
    Write OTAR RSI: 
    Allows editing of the radio set identifiers and message number period under the Keys tab. 
    These values are used when operating on a system capable of performing over-the-air-rekeying. 

  
    Show UID as Hex: 
    Shows values in the Unit ID Alias List as both decimal and hex. 
    Values must still be entered as decimal. 
  
    Show TGID as Hex: 
    Shows values in the Talkgroup Picklist as both decimal and hex. 
    Values must still be entered as decimal. 
  
    Show NACs as Hex: 
    Displays NACs in hexadecimal format instead of decimal. 
  
Tools Menu 
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System Keys: 

 
  
Loads a system key from one of three locations. RES requires a system key to access critical system lists in P25 
Trunking files. 
System keys can only be generated by RELM Wireless. 
Reset Permissions will clear all permissions given from loaded system keys. 
  
Voice Announcement: 

 
  
Loads or clears the voice announcement files from a chosen directory 
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Zone Cloning: 

  

 
  
Allows the user to clone single or multiple zones from a source radio to an unlimited number of targets. See the 
Zone Cloning Documentation for more details. 
  
Baud Rate Changer: 

 
  
The Baud Rate Changer application provides an easy alternative to changing the Baud Rate of the RS-485 
communication line between the RF deck and any attached control heads. 
Plug in the device as if you are programming the radio. Select the desired  Baud Rate, and click "Write". 
Different Baud Rates set on a control head versus the mobile will cause the control head to not boot. 
Be sure to program all units connected with the same Baud Rate. 
  

 
  
  
The Baud Rate is configurable per device. For example, a control head set to 115200 and an RF deck set to 
2000000 Baud can be connected together. 
However, the control head will not properly boot until one of the units has been changed to match the Baud Rate 
of the other. 
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Write Alignment Data: 

 
 
Adds a BK provided alignment file to the connected radio. 

  
 
Set Global Radio ID: 
  

 

 
  
Sets Conventional UID's, Trunking UID's, and OTAR RSI with one field. 
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Audit Info: 
 

 
  
Pulls Audit info from the currently connected radio. 
 
 
 
 
 
 
View Menu 
  

 
  

Editor View Selection: 

 
  
Switches between editing views. Switching to a different editor will change how RES is formatted and may hide 
some features that are less commonly used. 
  
Channel View Selection: 
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The Zone/Channel View feature allows single and multi-channel views so that all channel 
parameters can be viewed at a glance. 
Selecting the "Single Channel" view displays all the programmable parameters for a single 
channel location in the channel pane. 
Selecting "Multi Channel" view splits the right side channel pane horizontally. 
The highlighted Zone information will be shown in the top pane. An index of the high-lighted 
zone's activated channels will be displayed in the lower pane. 
The index will show all programmable parameters for each channel location and their current 
state. 
(The Zone tab will have to be selected to view this feature.) 
  
Multi-Channel View 
  

 
  
 
  
Single Channel View 
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Color Theme Selection: 

 
Changes the color theme of RES and all its windows. 
  
View Style Selection: 

 
Switches between system and cross-platform themes. 
  
 
 
Font Size: 

 
  
Increases or decreases the font size. This can also be achieved by pressing Ctrl+= to increase and Ctrl+- to 
decrease. 
  
  

Help Menu 
Help is a resource for information and assistance regarding RES functionality. 
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Parameter Search: 
  

 
  
  
Allows the user to search for radio parameters. The "transfer focus" option will automatically take the user to the 
place where the parameter can be changed and highlight the field. 
Shortcut for Search is Ctrl+F 
  
  

 
Help Doc 
Opens the help document. 
  
Check For Updates: 
Looks for a new release of Radio Editing Software 
  
Contact Customer Service: 
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Sends an email to the support email line. 
The "Read and Package All Versions From Attached Radio" checkbox will automatically download information 
from the connected radio to help with debug requests. 
  
Check Support Ticket Status: 

 
  
Checks the status of a support ticket. Support ticket numbers are generated automatically and emailed to the 
registered email 
  
Change Registered Email: 
Change your registered email that we may use to contact you about errors or issues with RES. 
  
About: 
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Provides information regarding RES's version number and release date. 
  

  
 

Tabs  

The main page of NeoVision's programming software includes 3 tabs that display the primary 
organization of the parameters for the radio: Global, System and Zone. 
  

 
  
  
Global: The Global tab is divided into two sub-pages: Common and Conventional. 
  
The Common page contains parameters which apply to radio operation at all times, regardless of 
the system or channel type actually selected. 
The radio RF band and the radio Electronic Serial Number (ESN) are shown on this page. 
The Conventional page contains those parameters which globally affect all conventional channels in 
the radio, regardless of the conventional system currently selected. 
The Trunking page contains those parameters which globally affect all trunking functionality in the 
radio regardless of the trunking system currently selected. 
  
System: The System tab contains parameters which relate only to a specific system. A radio may 
be able to operate on multiple conventional or trunking LMR systems. 
On each of these systems it may be assigned a different Unit ID, for example. 
  
Zone: The Zone tab is where specific zone and channel locations are populated. 
This includes zone and channel specific parameters such as transmit and receive frequencies, 
CTCSS/DCS call guards, talk groups and power levels. 
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Icon Bar 
 
Icon Bar  

The Icon bar allows quick selection of functions associated with the File menu via the icons. 
The "Task" bar allows the user to manage files and communicate with the radio with the click of an icon. 
  

 
  
  
Read Radio: 
Click the Read Radio button to upload information from the connected radio. 
  
Write Radio: 
Click the Write Radio button to download load the file information to the connected radio. 
  
OTAP: 
Clicking the OTAP button allows for Over-the-air programming of a radio 
  
  
Many items previously located at Menu Bar->Window can now easily be access via the title bar. 
  

  
Feature Editing Software: 

 
  
  
Allows the user to set some extra hardware options on the radio. 

25 

 



  
Version Info: 

  

 
  
  
Reads the firmware version information from the radio. 
"Copy To Clipboard" allows users to easily copy and paste the version information, for instance, if desired to put it 
in a help request. 
  
  
Audio Converter: 
A utility that allows users to record and convert audio files to the needed format for the Radio's voice 
announcement feature. 
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Auto Save History: 

 
  
  
A log of the files saved by the auto save feature. The auto save duration can also be set here. 
  
  
Child ASK Maker: 
  

 
  
  
A replacement for the original Child Key Maker program. Provides the ability to create Child ASKs (Advanced 
System Keys) for restricting users on what P25 programs are available for programming. 
Changes from the original Child Key Maker include: 
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  -The ability to convert legacy keys into ASKs (requires Master Key) 
  - Program up to 20 TGID/UID ranges 
  - Ranges are now defined as "Lower and "Upper" instead of "Base" and "Span" 
Batch Programming: 

 
  
  
An application that helps when programming the same file to multiple radios. 
Also allows the user to increment certain identifiers when programming multiple radios. 
  

Configure Menus: 
Changes what options are available on the radio's menu. 
  
Configure Buttons: 
Changes what the buttons on the radio are programmed to do. 
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Menus 
 
Conventional - Menu Items  

 
  
  
There are 2 menu lists available, Main Menu and Programming Menu. 
Reference the "Menu and Function Buttons" help page to view all available menu features. 
  
  
Main Menu: 
Assigned Main Menu items are displayed when the radio's menu button is pressed. 
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Programming Menu: 
The Programming menu contains functions that allow editing from the keypad. 
If any or all of the programming functions are assigned, "Keypad Programming" is automatically assigned as the last 
item in the Main Menu. 
  

 
  
  
Click items that should be added to the menu and they will become highlighted. Highlighted items will be moved to the 
top of the list and added to the radio's menu. 
  

By selecting the  key, all available items(not designated as button functions) can be 
moved to the "Assigned" list. 
To remove an item from the menu, simply click it to un-highlight it. To remove all the assigned items select the 

 key. 
 
To move an item, click and drag it to the desired position. 
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P25 Trunking Menu t 

  

 
  
  
Reference the "Menu and Function Buttons" help page to view all available menu features. 
  

 
  
  
Click items that should be added to the menu and they will become highlighted. Highlighted items will be moved to the 
top of the list and added to the radio's menu. 
  

By selecting the  key, all available items (not designated as button functions) can be 
moved to the "Assigned" list. 
To remove an item from the menu, simply click it to un-highlight it. To remove all the assigned items select the 

 key. 
 
To move an item, click and drag it to the desired position. 
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Buttons & Switches  

 
   
NOTE: Conventional and P25 Trunking buttons are assigned independently. 
It is recommended that common functions be assigned to the same button or switch 
Reference the "Menu and Function Buttons" help page to view all available button features. 
  
To adjust whether you are modifying Trunking vs. Conventional buttons, select the appropriate system type in 
the combo box in the upper left hand corner. 
  
Portable 
Generation 1 

 
Keypad Select: 
Keypad direct entry mode can be selected via the drop down menu. The options are None, 
Channel or Zone. 
  
Reverse Left Toggle Switch: 
Flips the operation of the left toggle switch. 
  
Reverse Right Toggle Switch: 
Flips the operation of the right toggle switch. 
  
Reverse Collar Switch: 
Flips the operation of the collar switch. 
  
Channel Knob Selects Zone: 
Enabling this check box will cause the channel select knob to become the zone select knob. 
  
Channel Soft Stop: 
(Mobile and CMD Portables only) Enabling this check box will prevent the mobile radio from 
wrapping from the last channel in the selected zone to the first channel if the channel knob 
continues to be rotated. 
  
Button Press: 
Sets how long the side buttons & emergency button must be pressed to activate. 
  
Button Deactivate Time: 
Sets how long the side buttons & emergency button must be pressed to deactivate. 
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Generation 2 

 
   
Clicking on the desired button will display a drop down menu listing the functions that may be 
assigned to that button. 
Double clicking on the item will then assign that function to the selected button and populate the 
associated description below with the assigned function. 
   
  
Mobile 
  

 
  
Channel Knob Selects Zone: 
Enabling this check box will cause the channel select knob to become the zone select knob. 
  
Channel Soft Stop: 
(Mobile and CMD Portables only) Enabling this check box will prevent the mobile radio from 
wrapping from the last channel in the selected zone to the first channel if the channel knob 
continues to be rotated. 
  
Clicking on the desired button will display a drop down menu listing the functions that may be 
assigned to that button. 
Double clicking on the item will then assign that function to the selected button and populate the 
associated description below with the assigned function. 
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Global  

The Global tab is divided into three sub-pages: Common, Conventional and P25 Trunking. 
  

 
  
The Common page contains parameters which apply to radio operation at all times. 
The Conventional page contains those parameters which globally affect all conventional operation. 
The Trunking page contains those parameters which globally affect all trunking operation. 
The Trunking tab will only show up if a trunking system has already been added. 

 

 
 

Global - Common  

The Global -Common tab is divided into five main sections: General, Keys, Dual Mode Scan, 
Mobile I/O, and GPS. 
  

 ` 
  
General: 
The General parameter settings are over all settings and are not system dependent. 
This page contains information relating to the Radio, Backlight settings, Passwords and Other 
setting such as knob functions. 
  
Keys: 
The Keys tab contains the encryption key CKR/SLN table for assigning key locations and their 
associated labels. 
  
Dual Mode Scan: 
The Dual Mode Scan list allows the selection of channel locations to be scanned when Dual Scan 
Mode is active. 
Dual Mode Scan allows the radio to scan the designated channel locations regardless of the 
system type. 
  
Mobile I/O: 
This tab is used for selecting the operation of a mobile radio's input and out connections. 
  
GPS: 
This GPS tab is used to setup the Global Positioning settings on radio's with optional GPS. 
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Common - General  

This page contains parameters which apply to radio operation at all times, regardless of the system 
or channel type selected. 
  

 
  
Radio 
  

 
  
ESN: 
The radio's Electronic Serial Number (ESN) is a display only field. It shows the ESN that has been 
assigned to the radio when manufactured. A NeoVision parameters file is tied to a specific radio via 
the ESN. This allows NeoVision to control the distribution of radio program files when security is a 
concern, for example, to inhibit the duplication of unauthorized radios on a trunking system. 
  
Change ESN: 
Brings up a window to enter a new Electronic Serial Number. 
  
Band: 
The Band field indicates the RF frequency band on which this particular radio will operate. 
  
Radio Name: 
Assigns an alphanumeric name to the radio. 
This value will appear on the display of a correctly programmed receiving KNG radio. 
  
Code Plug Version: 
Allows the user to track and organize code plugs. Optional, so may be left blank. 
Version information is found on the "Radio Info" screen next to "CP". 
  
Backlight 
  

 
  
On Display Change: 
(Portable only) If checked the display/keypad will illuminate any time display information or 
indicators change. 
Display changes include: channel selection, transmit, receive and scan indicators. 
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On Key Press: 
(Portable only) If checked the display/keypad will illuminate anytime a button is pressed. 
  
Duration: 
Selects the desired length of time for the display to be illuminated after either of the above settings 
is activated. Selectable from 1 to 6 seconds. 
  
Display Timeout: 
(Portable Only) Sets the length of time before the display blanks. 
  
Passwords 
  

 
  
Passwords can be used to control access to the radio. 
  
User: 
Enter the 6-digit User Password that is required to enter Keypad Programming mode. Providing the 
correct User Password allows programming access to any fields not locked by the Keypad Editing 
Lockout selections on the associated page. 
  
Power Up: 
This password is required on radio power up in order to interact with normal radio functionality. 
  
Admin: 
Using the radio's Administrator Password overrides the Keypad Editing Lockout selections and 
allows keypad programming of all available functions. 
To use the keypad editing lockout options, the user and Administrator passwords must be set to 
different values. 
  
Disable All: 
This selection will disable all current passwords. 
  
AMBE 
  

 
  
Noise Suppression: 
This setting enables/disables the AMBE+2™ vocoder's noise suppression feature. 
  
Automatic Gain Control: 
This setting enables/disables the AMBE+2™ vocoder's voice Automatic Gain Control (AGC) 
feature. 
  
Average Voice Level: 
This setting allows adjustment of the AMBE+2™ vocoder's AGC set point. AGC attempts maintain 
the incoming voice level to this level. 
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Automatic Tone Detection: 
Allows the AMBE+2™ vocoder to detect and correct tones received over a P25 digital channel. 
  
General 
 

 
  
Home Zone and Channel: 
Use the drop boxes to select what channel the radio returns to when the programmed Home button 
is pressed. 
  
Soft Power Down Timer: 
When soft power down is selected, this is the time until the radio goes into hard power down. 
  
Display MDC IDs as Decimal: 
Displays the numeric MDC ID of received signal. 
  
Disable Display Own Unit ID: 
When checked, a display line programmed for "Unit ID" will only show the P25 ID, or associated 
label, of an incoming digital signal. 
If unchecked, a display line programmed for "Unit ID" will display your radio's P25 ID whenever an 
incoming signal is not being received. 
  
Remember Last Channel in Zone: 
Upon a zone change, sets the channel to the channel last selected in that zone, regardless of the 
position of the channel select knob. 
  
DTMF Live Dial Global: 
Sets DTMF for all channels in all zones 
  
Date and Time 
 

 
  
Time Source: 
Sets the top priority for setting date and time 
  
Date and Time Manual Override: 
Allows for manually setting a time with highest priority 
  
Enable Daylight Savings Time: 
Adjust for daylight savings (add an hour) 
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Toggle Switch Zone Select 
  

 
 
Toggle Zone 1: 
In conjunction with Toggle Zone 2, this sets the two zones for a toggle switch when it is assigned 
the Zone Select function. 
Toggle Zone 2: 
In conjunction with Toggle Zone 1, this sets the two zones for a toggle switch when it is assigned 
the Zone Select function. 
  
Control Lockout Enables 
  

 
  
A check in the checkbox beside a control indicates that it will be locked out when Control Lockout is 
activated. 
  
GPS General 
 

 
  
Periodic Trigger Time: 
Time in seconds between auto transmit of GPS information. (3 - 65,535) 
NOTE: "Periodic" must be selected in the Trigger Condition window. 
  
Mode Selection: 
Determines whether a subscriber can turn off GPS on the radio 
    On: GPS is always on 
    Off: GPS is always off 
    Selective: Enable/disable GPS via radio using the "GPS menu or button 
  
Peer to Peer: 
Enabling this check box will allow Peer to Peer GPS capability. 
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Base Station Relay: 
When enabled, GPS coordinates received over the air are forwarded to a connected PC. 
Base station relays can be used with compatible GPS mapping software. 
  
GPS Trigger Conditions 
 

 
 
PTT: 
GPS information is sent with each push-to-talk. 
  
Periodic: 
GPS information is automatically transmitted at the programmed "Periodic Trigger Time". 
NOTE: Interval is set in the "General" window. 
  
Emergency: 
GPS information is sent during emergency transmissions. 
  
User Request: 
Allows radio user to manually select a target ID and send GPS information. 
  
 
GPS Tier 1 
 

 
  
Destination ID: 
Default Unit ID of the radio to send GPS information to. 
  
Dedicated Zone/Channel: 
When transmitting GPS data, the radio will temporarily jump to this zone/channel to perform any GPS transmissions. 
The radio will jump back to the previously selected zone/channel afterwards. 
This function only works when "Use Main Channel" is disabled. 
  
Use Main Channel: 
When enabled, all GPS transmission are sent on the currently selected channel. 
If disabled, the radio will perform the GPS transmissions on the "Dedicated Zone/Channel" 
  
Send as Impolite Data: 
By default, GPS Tier 1 data transmissions are done after the radio has ensured the channel is clear of all 
communications (polite). 
When this is enabled, the radio will transmit their GPS data as "impolite", which will send the data regardless of if the 
channel is open or not. 
  
Send PTT Trigger Pre-Tx: 
By default, the PTT trigger is sent after the PTT has been released. When enabled, the radio will instead send the 
GPS data as soon as PTT is pressed. 
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Mobile Accessory Serial Port 
 

 
 
Accessory Baud Rate: 
Sets the accessory Baud rate 
 
Enable IP 224: 
Enables the use of IP 224 
 
Enable ACU 1000: 
Enables ACU 1000 on the mobile accessory. 
  
Control Lockout Enables 
  

 
  
A check in the checkbox beside a control indicates that it will be locked out when Control Lockout is 
activated. 
  
  
Ethernet Settings: 
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Mobile: 
  

 
  
Ignition Line Low Timer: 
Sets a power down timer for a mobile. Once the timer expires, the radio will power off. 
  
HHCH Master of RCH Volume: 
When selected, volume control will only be on the Handheld Control Head. 
  
HHCH Master Volume Control: 
When selected, volume is controlled either through the Remote Head or the Handheld Control 
Head. 
  
Control Heads Monitor Tx Audio: 
(Mobile only) Allows non-transmitting control heads to monitor TX audio. 
  
Disable HHCH Speaker: 
Turns off audio on the Handheld Control Head. 
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Common - Keys  

This page contains encryption key parameter settings. 
  

 
  
  
P25 Encryption 
  

 
  
  
The Keys Table page contains SLN's (Storage Location Numbers) and Label information for the 
encryption keys contained in the radio's encryption module. 
  
SLN: 
Enter SLN's (Storage Location Numbers) in the table that corresponds to the location of the keys 
loaded into the radio. 
  
Alias: 
Labels can be assigned to each key. 
  
  
RCE Encryption 
  

 
  
  
RCE (RELM Compatible Encryption) is a method of encryption which is compatible with Motorola's 
ADP. 
  
SLN: 
Enter SLN's (Storage Location Numbers) in the table that corresponds to the location of the keys 
loaded into the radio. 
SLNs must be unique across all types of keys. The programmed RCE key must have its SLN in the 
P25 encryption table, the channel key selection then goes off that. (Range: 1-61439). 
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Key ID: 
ID of the encryption key (this is transmitted over the air) (Range: 1 - FFFF). 
  
Key: 
The key variable, the 16 hex-digit DES encryption variable. This is stored within the radio and 
cannot ever be read out. This is not transmitted over the air. 
  
Infinite KEK Retention: 
A check mark here means that Key Encryption Keys will be retained after the radio is turned off. No 
check mark means that the KEKs will be erased upon power down. 
  
Infinite TEK Retention: 
A check mark here means that Traffic Encryption Keys will be retained after the radio is turned off. 
No check mark means that the TEKs will be erased upon power down. 
  
Authentication Keyload Port: 
Selects the UDP port number for the port used to communicate with the KVL for supplying 
authentication keys to the radio. 
  
  
RSI 
  

 
  
  
RSI: 
Radio Set Indicator. When radio registers with the system, a data connection is established and the 
radio supplies KMF with the radio's IP address and the RSI 
  
KMF RSI: 
Key Management Facility. Default is 9999999. Required to operate in the OTAR system. 
  
MNP: 
Message Number Period. Provides additional security in the over the air rekeying of subscriber 
units. 
  
Group RSI: 
During OTAR delivery to a group of radios with the same encryption information, a group of RSI is 
used for more efficient delivery. 
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Common - Dual Mode Scan  

Dual Mode Scan will scan Conventional and P25 Trunking channel locations from within the same 
scan list. 
  

 
  
Settings 
  

 
  
Scan Hold Time: 
The Scan Hold Time allows the user to hear responses to calls before the radio resumes scanning. 
The Scan Hold Time can be programmed from 0 to 7.5 seconds. 
  
Talkback: 
The Talkback feature controls how the radio responds to scanned traffic. There are 2 modes of 

operation. 

Tx on Selected Channel: The radio will always transmit on the knob selected channel after 
receiving scan traffic. 
  
Tx on Active Channel: The radio will transmit on the same channel as the last received scan 
traffic if the radio is keyed before the hang time expires. 

  
Scan List Table 
  

 
  
  
Highlight the Zone entry box and click on the drop down arrow to select the desired zone. 
Highlight the Channel entry box and click on the drop down arrow to select the desired channel. 
  

The  and  buttons are used to enable/disable list entries. 
The list entries will then display the selected channel locations. 
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Common - Voice/Mic Prefs  

 
  
Dual Speaker Output: 
(Portable only) When checked audio is available on both the internal speaker and the speaker 
microphone speaker when attached. 
  
Disable Unprogrammed Switch Error Tone: 
Disables the audible tones. 
  
Standard Mic Support: 
Should be selected for mobile radios with a standard microphone for proper hang-up function. 
  
Disable Low Battery Audible Alert: 
When selected, low battery audible alert is disabled. 
  
Tone Volume: 
Selects the tone volume (Knob, Low, Medium, High). 
  
Minimum Volume: 
Prevents the volume from decreasing below a pre-set level, regardless of the setting of the volume 
knob. Use the drop box to select either User Selectable, Level 1, Level 2, Level 3, Level 4, or 
Disabled. 
  
Send Alert Tone Duration: 
Used in conjunction with the "Send Alert Tone" button, when pressed and held the radio will 
transmit a 781.3Hz tone for the programmed duration. Works on analog/digital/mixed-mode or 
trunking channels. 
  
Analog Volume Adjust Tone: 
A tone will play any time the volume knob is adjusted while on an analog channel. 
  
Digital Volume Adjust Tone: 
A tone will play any time the volume knob is adjusted while on a digital channel. 
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Common - PC Access Password  

 

Change PC Access Password: 
Change or assign a password to access the saved file. 
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Common - Mobile I/O  

This page is used to set mobile radio input and output functions. 
  

 
  
Outputs 
  

 
  
There are three output ports available from the 25-pin connector on both mobile radios and remote control heads. 
  
Output Mode: 
Determines what event will cause the output to toggle. 
  

Auxiliary 1 Button - Toggles when Aux 1 button is pressed or selected from the menu. 
  
Auxiliary 2 Button - Toggles when Aux 2 button is pressed or selected from the menu. 
  
Auxiliary 3 Button - Toggles when Aux 3 button is pressed or selected from the menu. 
  
Carrier Detect - Toggles on whenever carrier is detected, off when carrier drops. 
  
Active Rx - Toggles when the receiver is active. 
  
Voice Mute Trip - Toggles when Volume Mute is triggered. 
  
Call Alert Received - Toggles when a Call Alert is received. 
  
Active Tx - Toggles when the transmitter is active. 
  
Active MSAT - Toggles when the MSAT is active. 
  

Output Active Level: 
Determines whether the output is high or low when enabled. 
  
Binary Mode: 
Indicates that the output lines are to be used as binary address lines to communicate a Call Alert in a trunking system. 
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See Sentinel IDs under P25 Trunking. 
Inputs 
  

 
  
There are two inputs available from the 25-pin connector from both mobile radios and remote control heads. 
These inputs can invoke various radio functions. 
  
Input Mode: 
  

Emergency - Detected input initiates emergency call. 
  
PTT - Detected input initiates push-to-talk. 
  
Monitor - Detected input places the radio in monitor mode. 
  
Zeroize - Detected input removes all encryption keys. 
  
Voice Mute - Detected input puts radio in Voice Mute mode. 
  
Tx Encryption - Detected input enables/disables encryption on switchable encryption channels. 
  
Tx Mode - Detected input toggles digital/analog transmit on selectable Tx mode channels. 
  
Tx Power - Detected input toggles high/low Tx power on selectable Tx power channels. 
  
Channel Scan - Detected input initiates Channel Scan. 
  
Zone Scan - Detected input initiates Zone Scan. 
  
Priority Scan - Detected input initiates Priority Scan. 
  
Handset off Hook - Detected input initiates Handset off Hook. 
  
ACC PTT - Detected input initiates Accessory PTT. 
  

  
Input Active Level: 
Determines whether the input is triggered by high or low input. 
  
Input Type: 

Switch - Indicates that the selected action is initiated be a single change in the input (low to high, or high to low). 
  
Momentary - Indicates that the selected action is initiated be a change, then a revert, in the input (low-high-low). 
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Common - FSI Options  

Fixed Station: 
  

 
  
Network settings used to configure a mobile radio as a digital fixed station interface. Must be used 
in conjunction with an authorized fixed station console application. 
  
IP Address: 
IP is a numerical label assigned to each device participating in a computer network that uses the 
Internet Protocol for communication. 
  
Subnet Mask: 
32-bit value that is used to distinguish the network ID from the host ID in an arbitrary IP address. 
  
Default Gateway: 
The node on the computer network that the network software uses when an IP address does not 
match any other routes in the routing table. 
  
Control UDP Port: 
Indicates the transport port used to receive RTP packets from remote gateway. The P25 DFSI 
Standard identifies port 7000 as the default control port. 
  
Voice UDP Port: 
Indicates the port used for VOIP. No default port is identified for the Voice UDP Port. 
  
Audio Type: 
Audio media type and codec. 
  
Channel Index Zero-Based: 
For DFSI channel change operations, the console and the fixed-station must agree that the 
channels either begin with channel 0 or channel 1. 
If the console expects the channels to start at 0, this parameter should be enabled; otherwise it 
should be disabled (meaning the channels start at 1). 
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Global - Conventional  

The Global - Conventional tab contains features that control radio operation on any conventional 
system. 
The tab contains one main section that contains Display, Analog Signaling, Radio Features, Unit 
Call, Transmit Features, and Other settings. 
  

 
  
General: 
The General parameter settings control generic conventional functionality regardless of the active 
conventional system. 
  
Features: 
The Features parameters controls radio functions such as Priority Scan timer, Talk Back Scan and 
Busy channel modes. 
  
Keypad Editing Lockouts: 
Settings on this page control what functions are accessible via Keypad Programming. 
  
Menus: 
Determines which conventional system features will be accessible via the radio's Menu list. 
  
Buttons: 
Assigns conventional system functions to the radio button controls. 

 

 
 
Conventional - General  

This page contains parameters which apply to radio operation when the active system/channel type is conventional. 

 
   
Display 
  

 
  
  
The settings in this section determine what information is visible on the radio display when a conventional channel is 
selected. The display supports three lines of text. 
All three display lines can be programmed to alternate displayed information. Each line is individually programmable. 
Each of the display lines can be populated with one of the following items: 
     Channel Label, Frequency, Channel Number, Unit ID, Received Talkgroup ID, Rx Pick List selections, Tx Pick List 
selections, Zone Label, Zone Number/Channel Number, 
     Zone Number, Rx/Tx Key, Received Subaudible tone, Received DTMF, Received MDC, Channel Number/Zone 
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Label, Radio Name, Date and Time or None. 
Analog Signaling 
  

 
  
  
Deviation: 
This drop down menu sets the modulation level of an analog DTMF or MDC signal. 
  
Pre-Delay: 
This drop down menu sets the time between PTT and the start of the selected DTMF/MDC signaling. 
This front porch time allows repeaters in a conventional system to perform squelch detection and decode any sub 
audible signaling before the signaling is transmitted. 
  
Pre-Tx ANI Go-Ahead Beep: 
If checked the radio emits a beep after the Pre-Tx ANI is sent. 
  
  
Unit Call 
  

 
  
  
Unit Call: 
The settings in this section govern Conventional Unit Call functionality. 
  
Enabled: 
Selecting the check box enabled the conventional digital unit call functionality in the radio. 
  
Beep: 
If checked the radio will emit an alert tone whenever receiving unit call traffic. 
  
Idle Time: 
Determines the amount of time the radio waits before automatically exiting Unit Call mode. 
This time relates to both unanswered calls and active calls that have gone idle. 
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Other 

 
  
  
Discriminator Monitor: 
When enabled, supplies discriminator (unfiltered) audio to the speaker during open monitor. When disabled, supplies 
filtered and de-emphasized audio to the speaker during open monitor. 
This feature allows the radio to be used in conjunction with an external decoder for various types of signaling that are 
sensitive to filtering and de-emphasis. 
  
Tone Remote Interface: (Mobile only) 
This selection must be active if the radio is to be interfaced with a Tone Remote station. 
  
Talkaround Persistence: 
Indicates that Repeater Talkaround will not revert to inactive after a channel change. 
  
Default Squelch Level: 
Sets the default level when squelch is adjusted through the Squelch Adjust menu, or when new channels are created 
in keypad programming. 
  
Radio Features 

 
Ignore Transmission from Own UID: 
Causes the radio to mute any received transmissions from a unit's own P25 UID. 
  
Unmute only after Encryption Parameters Available: 
If checked, encrypted channels unmute only after receiving encrypted signals that match the 
encryption key assigned to the channel. 
  
Mixed Mode Signal Quality Holdoff: 
Delays the unmuting of a qualified mixed mode signal for the programmed amount of time. 
  
Priority Scan Period: 
Use the drop down menu to program the rate at which the Priority Channels are sampled when the 
radio is operating in Priority Scan Mode. 
Note: A sampling rate of at least .5 seconds is recommended when scanning digital priority traffic. 
  
Nuisance Channel Delete Legacy Mode: 
If checked and Channel Scan is active, a nuisance channel can be temporarily removed from the 
scan list using this function. 
Press and hold the button while the nuisance traffic is active and scanning will no longer stop on 
that channels traffic. 
A removed channel will be restored to the list on a channel change, scan on/off or upon radio 
power cycle. 

52 

 



  
TX DTMF Pre-emphasis: 
Turns on pre-emphasis when sending DTMF Tones. 
  
Mobile Microphone Offhook Monitor: 
(Mobile only) When the radio is taken off hook, any scanning is halted and the radio enters monitor 
mode. The radio only unmutes when voice traffic is present. 
  
Offhook Scan Enabled: 
(Mobile only) With this feature selected, the radio will continue to scan when in the "Offhook" state. 
  
Offhook Talkback Enabled: 
(Mobile only) When enabled, if the mobile is scanning and the mic is taken off hook, scan will 
temporarily be disabled and the mobile will switch to the channel of the last reception. Once the 
mic is put back on hook, scan will resume and the radio will return to the idle channel 
  
Transmit Features 
  

 
  
Talkback Scan: 
If checked, pressing PTT while a scanned channel is active or before the scan hold time expires 
causes the radio to transmit on the frequency of the active receive channel. 
If unchecked, the radio will transmit on the frequency of the selected channel. 
If Priority Scan is active and Transmit on Priority 1 is enabled, all transmissions will occur on the 
designated Priority 1 channel. 
  
Mixed Mode Talkback: 
Channels programmed to receive in Mixed mode will receive both digital and analog traffic 
exhibiting the proper signaling (CTCSS/DCS, NAC, talk group, etc...) 
If checked, pressing the PTT during the hang time will cause the radio to transmit in the same 
mode, analog or digital, as the received traffic. 
If unchecked, the radio will transmit using the channels programmed mode. 
  
NAC Talkback: 
Indicates that the received NAC/Talkgroup ID will be used for transmit. 
  
Talkback Use Rx Key: 
If checked, after receiving encrypted traffic, the radio will respond using the same encryption key 
as the received traffic. 
If unchecked, the radio will use the encryption key assigned to the channel when responding to the 
call. 
  
Unit to Unit Callback: 
Allows the radio to accept and respond to unit calls received while scanning. 
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Conventional - Features  

This page enables and configures a variety of conventional features. 
  

 
  
Radio Features 
 

 
Ignore Transmission from Own UID: 
Causes the radio to mute any received transmissions from a unit's own P25 UID. 
  
Unmute only after Encryption Parameters Available: 
If checked, encrypted channels unmute only after receiving encrypted signals that match the 
encryption key assigned to the channel. 
  
Mixed Mode Signal Quality Holdoff: 
Delays the unmuting of a qualified mixed mode signal for the programmed amount of time. 
  
Priority Scan Period: 
Use the drop down menu to program the rate at which the Priority Channels are sampled when the 
radio is operating in Priority Scan Mode. 
Note: A sampling rate of at least .5 seconds is recommended when scanning digital priority traffic. 
  
Nuisance Channel Delete Legacy Mode: 
If checked and Channel Scan is active, a nuisance channel can be temporarily removed from the 
scan list using this function. 
Press and hold the button while the nuisance traffic is active and scanning will no longer stop on 
that channels traffic. 
A removed channel will be restored to the list on a channel change, scan on/off or upon radio 
power cycle. 
  
TX DTMF Pre-emphasis: 
Turns on pre-emphasis when sending DTMF Tones. 
  
Mobile Microphone Offhook Monitor: 
(Mobile only) When the radio is taken off hook, any scanning is halted and the radio enters monitor 
mode. The radio only unmutes when voice traffic is present. 
  
Offhook Scan Enabled: 
(Mobile only) With this feature selected, the radio will continue to scan when in the "Offhook" state. 
  
Offhook Talkback Enabled: 
(Mobile only) When enabled, if the mobile is scanning and the mic is taken off hook, scan will 
temporarily be disabled and the mobile will switch to the channel of the last reception. Once the 
mic is put back on hook, scan will resume and the radio will return to the idle channel. 
 

54 

 



  
Transmit Features 
  

 
  
Talkback Scan: 
If checked, pressing PTT while a scanned channel is active or before the scan hold time expires 
causes the radio to transmit on the frequency of the active receive channel. 
If unchecked, the radio will transmit on the frequency of the selected channel. 
If Priority Scan is active and Transmit on Priority 1 is enabled, all transmissions will occur on the 
designated Priority 1 channel. 
  
Mixed Mode Talkback: 
Channels programmed to receive in Mixed mode will receive both digital and analog traffic 
exhibiting the proper signaling (CTCSS/DCS, NAC, talk group, etc...) 
If checked, pressing the PTT during the hang time will cause the radio to transmit in the same 
mode, analog or digital, as the received traffic. 
If unchecked, the radio will transmit using the channels programmed mode. 
  
NAC Talkback: 
Indicates that the received NAC/Talkgroup ID will be used for transmit. 
  
Talkback Use Rx Key: 
If checked, after receiving encrypted traffic, the radio will respond using the same encryption key 
as the received traffic. 
If unchecked, the radio will use the encryption key assigned to the channel when responding to the 
call. 
  
Unit to Unit Callback: 
Allows the radio to accept and respond to unit calls received while scanning. 
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Conventional - Keypad Edits Lockout  

From this page all available keypad programmable options can be locked to prevent changes by the radio operator. 
  

 
  
Any function selected in the Keypad Editing Lockout screen will not be available when the User Password is used to 
enter keypad programming mode. 
  

 
  
!!! Warning !!! 
If the passwords are disabled keypad lockouts are ignored and all keypad programming functions are accessible. 
Keypad lockouts can be overridden by entering keypad programming mode using the Administrator Password. 
If you are using lockouts, be sure to set the Administrator and User passwords differently under the "Common - 
General" tab. 
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Global - P25 Trunking  

The Global - P25 Trunking tab contains trunking features that control radio operation regardless 
of the active P25 Trunking system. 
The tab contains a small General section. Also, Trunking Systems have different Menus and 
Buttons than conventional systems. 
  

 
  
General: 
The General parameter settings control generic trunking functionality for all programmed P25 
Trunking systems. This page contains settings such as Display, Site Trunking and Out of Range 
indication settings. 
  
Menus: 
Determines which trunking features will be accessible via the radio's Menu list. 
  
Buttons: 
Assigns trunking functions to the radio button controls. 

 

 
P25 Trunking - General  

This page contains parameters which apply to radio operation when the active system/channel type is P25 Trunking. 
  

 
  
Display 
  

 
  
The settings in this section determine what information is visible on the radio display when a P25 Trunking channel is 
selected. The display supports three lines of text. 
The display supports three lines of text. All three display lines can be programmed to alternate displayed information. 
Each line is individually programmable. 
Each of the display lines can be populated with one of the following items: 
    Channel Label, Channel Number, Unit ID, Received TG, Zone Label, Zone# : Channel#, Zone Number, Rx/Tx Key, 
    Channel # + Zone Label, Radio Name, Site Affiliation Alias, Date and Time or None. 
   
Trunking Indicators  

 
  
Site Trunking Warning: 
Determines what will be displayed and/or heard when the radio is operating in a site trunking condition. 
The optional selections are Tone and Display, Display Only, Tone Only or None. 
  
Out of Range Indications: 
Determines what will be displayed and/or heard when the radio is out of range of the system. 
The optional selections are Tone and Display, Display Only, Tone Only or None. 
  
Roaming Notification: 
If active, it will give an audio or display indication when the radio roams to a new site. 
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Menu and Function Buttons & Switches  

The chart below details the features available for assignment to the "Main" menu or as a function 
button. 
The features are system dependent. 
  
The chart below shows available for menu, switch or button assignment. 
  

  Menu Switch Button Label Trunk Conv. 

Accessory I/O Enable x   x IO-EN x x 

Auxiliary 1/2/3 x   x AUX1/2/3 x x 

Backlight x x x LITE x x 

Battery Life x   x LIFE x x 

Bluetooth (KNG2 Feature) x   x BT x x 

Call Alert x   x ALRT x x 

Channel Add/Delete x   x CHAN+/-   x 

Channel Scan x x x SCAN   x 

Channel Scan List x   x SCN+   x 

Channel Select x   x CHAN x x 

Cloning x     -   x 

Contrast x     - x x 

Control Lock x x x LCK x x 

Date and Time x   x DATE x x 

Dual Mode Scan x x x DSCN x x 

Dual Mode Scan List x   x DSED x x 

Emergency1     x - x x 

Enhanced Scan x x x ESCN   x 

Evacuation Tones x   x ET   x 

GPS* x   x GPS x x 

Hang Up x   x HANG   x 

Hard Power Down     x PWRD x x 

Home Channel x   x HOME x x 

Inhibit x   x INH   x 

Keyset Select x   x KSET x x 

Menu     x MENU x x 

Minimum Volume x   x VOL x x 

Monitor x   x MON   x 

Nuisance Delete     x DEL   x 

Phone x   x PHN   x 

Picklist - Rx CxCSS x   x RXCG   x 

Picklist - Rx NAC x   x RXNC   x 

Picklist - Talkgroup ID x   x TGID   x 

Picklist - Tx CxCSS x   x TXCG   x 

Picklist - Tx NAC x   x TXNC   x 

Picklist-KEY** x   x KEY   x 

Priority Channel Select x   x PRI   x 

Priority Scan x x x PSCN x x 

Priority Scan List x   x PSED x   

Quick User Status 1/2/3/4     x STS1/2/3/4 x   
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Radio Accountability Tone x   x RAT x x 

Radio Check x   x RCHK   x 

Radio Info x     - x x 

Rekey Request*** x   x RKEY x x 

Repeater Talkaround² x x x T/A   x 

Send Alert Tone     x SNDT x x 

Send Signal     x SEND   x 

Short Message Update x   x MSG x   

Site Display**** x   x STDS x   

Site Lock**** x   x STLK x   

Site Search**** x   x STSR x   

Squelch Adjust x   x SQL   x 

Surveillance Mode x x x SURV x x 

Talkback x   x TKBK   x 

Text Message x   x TXT   x 

Two-Tone Select x   x TONE   x 

Tx Digital/Analog x x x TXAD   x 

Tx Inhibit x   x - x x 

Tx Power x x x PWR x x 

Tx Secure** x x x SEC x x 

Unihibit x   x UNINH   x 

Unit Call x   x UNIT x x 

User Status x   x STS   x 

Version x     - x x 

Voice Mute² x   x MUTE   x 

Zeroize Keys** x   x ZERO x x 

Zone Scan x x x ZSCN   x 

Zone Scan List x   x ZSC+   x 

Zone Select x x x ZONE x x 

 

1  Emergency button can only be assigned to the orange button. 
² Works on a per-channel basis. 
* Requires GPS option. 
** Requires Encryption option. 
***Requires Encryption and OTAR options. 
****Requires P25 Trunking option. 

   
  
Keypad programming menus are accessible in conventional systems only. 
Assigned programming items are accessed by selecting "Keypad Prog" from the radio's programmed menu items. 
  
Available Programming Menus 
P25 ID Call List 
CxCSS Pick List 
Keypad 
NAC Pick List 
Talkgroup ID Pick List 
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Systems  

The second tab on the main page is titled "System". This tab accesses those parameters that are 
likely to change when a radio is to operate on different systems. 
  
"System" refers to any set of RF infrastructure equipment (trunking or conventional) that is 
administered by some controlling agent or agency. A state vs county system, for example. 
  
A radio's assigned Unit ID may change when it operates on the county trunking system vs the state 
trunking system due to the different agencies administering the systems. 
  
The available features on one system may differ depending on the FNE (Fixed Network 
Equipment) that make up the system or the manner the equipment is configured. 
  

 
  
Add/Delete a System 
To add a new conventional system, click the +CS button. 
To add a new P25 trunking system, click the +TS button. 
  
To Delete a system, highlight the system and click the -S button. 

 

 
System - Conventional  

The System - Conventional tab will display parameters for the selected conventional system. 
  

 
  
  
Each conventional system has some general options and these other subcategories: 
Add. Options, Unit ID Alias List, CxCSS Picklist, NAC Picklist, Talkgroup Picklist, Two-Tone List, DTMF 
List, MDC List, Five-Tone List, User Status, Text Messages, Data/OTAR, and Phone. 
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Conventional System: General  

The Conventional - General page contains parameters which apply to radio operation on the 
selected conventional system. 
  

 
  
P25 Unit ID 
  

 
  
The ID section programs the conventional P25 Unit ID. 
The available unit id range is from 1 to 9999999. 
  
Priority Scan Mode (System) 
  

 
  
For each system, up to two channels can be designated as priority channels. 
In Priority Scan mode these priority channels, Pri 1 and Pri 2 are periodically checked for activity 
even when monitoring a non-priority channel's active traffic. 
Activity on Pri 2 preempts traffic on any of the non-priority channels. 
Activity on Pri 1 preempts traffic on any channel including Pri 2. 
System Priority Scan will automatically scan across zones when enabled. 
  
Use the drop box to assign the Priority 1 and Priority 2 channels. 
When "Use Main Channel" is selected, the currently selected channel will be either Pri 1 or 2. 
Use Main Channel cannot be assigned to Pri 1 and 2 concurrently. 
  
  
Tx on Priority 1: 
If the radio is programmed to "Transmit on Priority 1", all transmissions will occur on PR1 when 
Priority Scan is enabled. 
  
NOTE: System Priority Settings override the "Zone" based priority settings. 
To set Zone specific priority channels, the System Pri must be disabled. 
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Voice Mute 
  

 
  
  
When Voice Mute is selected from the radio's menu or programmed switch or button, the radio speaker is muted until 
a programmed two-tone, MDC or DTMF paging call is received. 
  
Voice Mute Reset: 
This setting will determine how the radio resets after being activated by a Paging event. 
"Manual" will require the user press the "Voice Mute" function button/menu item to reset the radio 
to idle. 
"Auto" and "Auto w/Carr" settings will reset based on the Auto Reset timer. 
Using the Auto w/Carr selection will keep the radio active if additional carrier activity is received 
during the reset time cycle and will only return to its idle state after no carrier activity has been 
detected for duration of the Reset time. 
  
Voice Mute Reset Time: 
This setting will determine when the radio will automatically reset after a Paging event has 
occurred. 
  
Man Down Settings 
  

 
  
The Man Down feature, if enabled, will put the radio in Emergency Mode after a specified period in 
a horizontal position. 
  
Trigger: 

Horizontal - Indicates that Emergency Mode will be triggered after the radio has been horizontal for the specified 
interval. 
  
Horizontal + Motionless - Indicates that Emergency Mode will be triggered after the radio has been horizontal and 
motionless for the specified interval. 

  
Pre-Warning Timer: 
Countdown to the warning beep. Indicates the length of time, after meeting the trigger condition, 
before the warning timer begins beeping. 
  
Post-Warning Timer: 
Countdown to Emergency Mode. Indicates the length of time that the warning beep sounds. Once 
these seconds are counted down, Emergency Mode is activated. 
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P25/MDC Emergency Mode 
  

 
   
P25 Emergency Mode Operation 
When Emergency mode is activated, each transmission will contain a bit in the data stream 
indicating an emergency condition as defined in the APCO Project 25 standards. 
P25 Emergency operation only applies to channels programmed for Digital or Mixed mode 
transmissions. If the channel is programmed for Mixed mode transmit, the "Tx Digital" switch must 
be on. 
To place an emergency group call, press and hold the programmed emergency button (as 
assigned in the Conventional - Buttons page) until the radio beeps and the display flashes, then 
press PTT. 
  
All scanning and priority scanning functions will be disabled. If the radio is in Unit-to-Unit call mode, 
that mode will be exited and the radio placed in Emergency mode. 
Each subsequent press of PTT will cause the radio to transmit on the designated emergency 
zone/channel location with the emergency bit set, indicating an emergency condition. 
A press and hold of the emergency button or power cycling the radio will return the radio to normal 
operation. 
  
MDC Emergency Mode Operation 
When Emergency mode is activated on an analog channel, MDC emergency information is 
transmitted providing that the emergency channel is part of a zone populated with an MDC ID. 
(See "Zone Settings" to set an MDC ID.) 
  
Emergency Settings 
Zone/Channel: 
This setting indicates the emergency zone and channel location for all conventional emergency 
calls. 
A P25 digital or MDC analog emergency is sent according to the emergency channels transmit 
mode. 
  
Tone on Received Emergency Call: 
An alert tone will sound when an emergency call is received. 
  
Emergency Alarm: 
An emergency signaling bit is automatically sent on a digital conventional channel when the 
emergency button is pressed. 
This alarm will inform the console and other radio users that an emergency situation is occurring. 
When an Emergency Alarm is sent, the radio listens for an acknowledgment message from a 
console. 
  
Alarm Tries: 
   An emergency alarm can be sent multiple times in an attempt to receive an acknowledgment. 
    Impolite Tries: The alarm is sent regardless of receiver status. 
    Polite Tries: The alarm is sent only when the channels are not busy. 
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Emergency Call: 
This feature consists of an emergency signaling bit being sent with each PTT on the designated 
emergency channel that indicates an active emergency status of the call. 
  
Emergency Hot Mic: 
This check box enables Emergency Hot Mic functionality. 
When an emergency call has been initiated the radio will automatically transmit the emergency call 
for the duration of the Hot Mic Tx Period and then dekey. 
  
Enable Evacuation Tone Sequence: 
Allows the evacuation tone to be sent when the user presses and holds the PTT button and then 
presses the orange emergency button. 
This tone will continue to send for the duration that the user holds PTT. 
  
Hot Mic Tx Period: 
This setting determines the length of time the radio will automatically transmit an emergency call if 
Hot Mic is enabled. 
  
Encryption 
  

 
 
Radios with digital encryption options can hold up to 32 DES or AES keys. 
Each channel is assigned a default key for transmit. The channel can be locked to a specific 
transmit key or a key may be selected from the encryption key list 
(ex Global-Common-Keys). 
Received encrypted traffic is decoded by any key residing in the radio. 
A keyloader and keyload interface cable are required to program keys to the radio. 
  
Clear Transmit Talk Permit Tone: 
The radio plays a low single beep to notify the user they are transmitting an unencrypted signal. 
  
Secure Transmit Talk Permit Tone: 
The radio plays a low triple beep to notify the user they are transmitting an encrypted signal. 
  
Allow Key Set Selection: 
Allows the user to select a different keyset via the menu or function button. 
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Vote Scan 
  

 
  
RSSI Threshold: 
Determines the Receive Signal Strength indicator (RSSI) level at which a voted site's signal level is 
acceptable. 
If the radios current site falls below this threshold, it will attempt to find a stronger signal from one 
of the other voting sites. 
  
Delay Timer: 
This setting determines the time the radio will delay before taking RSSI measurements. 
  
Hold Time: 
Determines the amount of time the radio will remain on the voted repeater after receiving voice 
traffic. 
  
 
Additional Options 

 
  
  
Scan Hold Time: 
The Scan Hold Time allows the user to hear responses to calls before the radio resumes scanning. 
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It also allows time for the user to respond to a call when Talk Back Scan or Mixed Mode Talk Back 
enabled. 
  
Call Alert Reset Time: 
Allows call alert to expire after the set time period 
  
Digital RX Modulation Type: 
Specifies the type of modulation expected to be received on conventional channels as: C4FM, 
CQPSK, both, or Widepulse. It should always be set to C4FM unless otherwise directed by 
engineering. 
  
Beep on Priority 1 Rx: 
Indicates that a beep will sound when Priority 1 channel becomes active. 
  
Tx Time Out Period: 
The Transmit Time-Out Period limits the duration of calls and guards against accidentally keying of 
the transmitter and tying up the radio system. 
The timer can be turned Off or set for a duration of 15 to 255 seconds, in 15 second increments. 
  
Power: 
This feature allows the radios "High" power level to be adjusted to either the highest possible 
output power range (High) or to roll back that level to a lower predetermined threshold. 
  
Busy Channel Lockout: 
Busy Channel Lockout prevents the radio from transmitting when other traffic is occurring on the 
active channel. 
  

Off: No busy channel transmit limiting will occur. 
  
Indicate: This setting will display "Busy" momentarily and an alert tone will sound if conflicting 
traffic is present, but the radio is still allowed to transmit. 
  
Lockout: This setting prevents the radio from transmitting, "Busy" will be displayed and an alert 
tone will sound until the PTT is released. 
  
Lockout with Override: This setting prevents the radio from transmitting, "Busy" will be displayed 
and an alert tone will sound until the PTT is released. 
However a rapid release and press of the PTT will allow the radio to transmit. 
  
Automatic: The setting will display "Busy" momentarily and an alert tone will sound. The radio 
will then revert back to receive mode and monitor the active receive traffic. (carrier mode only) 

  
ANI Disable Time: 
When not 0, this specifies the period during which ANI will not be sent if PTT is pressed during this 
time on a channel for which ANI is enabled. 
When properly set, this produces the result that ANI will only be sent once on the first PTT of a 
typical conversation involving multiple PTTs. 
  
Radio Accountability Tone: 
Allows the user to transmit a pre-programmed set of DTMF digits by pressing and holding the 
"RAT" soft-key. The user can program up to 10 DTMF digits. 
  
Disable System Priority Channel Selection from Keypad: 
Indicates that a System Priority Channel cannot be changed from the keypad menu. 
  
Ringback Enabled: 
When enabled, this causes a radio receiving a DTMF voice mute signal to key the transmitter and 
send a 697Hz tone for 1sec, which serves to inform the user that sent the DTMF voice mute signal 
that this signal was received by the target radio. 
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Conventional System: Unit ID Alias List  

The Conventional - Unit Call tab contains parameters which apply to radio operation on the 
selected conventional system. 

 
  
P25 Unit ID/Unit Call List 
  

 
  
  
Security 
Unit Call Key: 
Selects which SLN is used to encrypt Unit-to-Unit calls. 
  
Unit ID Table 
Entries in this table will be assigned to the Unit Call list and be accessible to the user via the Unit 
Call/Call Alert menu or function button. 
Rx ID's and Unit Calls received from the ID's populated on this table will then be displayed as the 
assigned Label instead of the actual unit id number. 
  
Alias: 
The label that is displayed when activity to/from a radio with associated P25 ID is detected. 
  
ID: 
P25 ID number for the associated label. 
  

The  and  buttons are used to enable/disable additional unit 
id entries (256 max.). 
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Conventional System: CxCSS Picklist  

 

 
  
  
  
CxCSS Picklist 
  

 
  
The list allows the user to choose CTCSS/DCS guard values for analog receive and transmit channels. 
  
Value: 
To program a standard CTCSS tone or CDCSS code, select the picklist entry and click on the right side of 
the Value field to bring up the drop-down list. Scroll through the list and select the desired call guard for the 
current line. 
  
To program a non-standard CTCSS tone or CDCSS code, select the picklist entry key and enter the 
desired value. CDCSS codes must start with a D. Non-standard tones or codes will be displayed in RED. 
  
Invert DCS: 
A true value will invert the programmed DCS tone. 
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Conventional System: NAC Picklist  

  

 
  
  
NAC Picklist 
  

 
  
The NAC Pick list allows the user to choose NAC codes for digital receive and transmit channels. 
The associated menu selection items are Rx NAC and Tx NAC. 
  
To program the NAC codes select Value, type the desired NAC value for the current channel (32 
max). 
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Conventional System: Talkgroup Picklist  

  

 
  
  
Talkgroup Picklist 
  

 
  
  
The Talkgroup Pick List allows the user to choose the Talkgroup for digital conventional receive 
and transmit channels (32 max). 
  
Talk Group ID's range is from 1 to 65535. 
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Conventional System: Two Tone List  

  

                 
  
  
Two-Tone Call List 
  

 
  
This list is populated with frequency pairings that will be used to alert the radio that specific voice 
traffic is being received. 
The radio will idle, ignoring other voice traffic until it receives the proper two tone sequence. 
The radio will then awaken and receive specific voice traffic designated for the user. 
Two-Tone list entries are selected on the "Zone" tab. 
  

The  and  buttons are used to enable/disable additional 
Two-Tone ID entries (100 max.). 
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Conventional System: DTMF List  

  

 
  
  
DTMF List 
  

 
  
Creates a list of Unit IDs which is used by the Voice Mute and ANI features (Channel General tab). 
  

The  and  buttons are used to enable/disable additional Unit 
ID entries (100 max). 
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Conventional System: MDC List  

  

 
  
  
MDC List 
  

 
  
Creates a list of Unit IDs which is used by the ANI feature (Channel General tab). 
  

The  and  buttons are used to enable/disable additional 
Group and Unit ID entries (512 max). 
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Conventional System: Five-Tone List  

  

 
  
  
Five-Tone List 
  

 
  
Creates a list of five-tone CCIR selcalls used by the Voice Mute and ANI features (Channel General tab). Each entry 
must contain five digits. 
  

The  and  buttons are used to enable/disable additional 
Five-Tone ID entries (100 max). 
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Conventional System: User Status List  

  

 
  
By populating specific status messages in this list, the user can send status updates to a specific 
unit id, talk group or a console using the User Status menu item or via function button. 
  

 
  
Enter the status Label and its associated number. 
The list members will now be available when the User Status feature is selected. 
  
When sending a User Status Message, only the ID is sent. 
The receiving radio displays the Label associated with the ID number. 
  

The  and  buttons are used to enable/disable additional unit 
id entries (256 max.). 
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Conventional System: Text Messages  

  

 
  
  
  

 
  
Message: 
Enter text for predefined text messages. 
  
ID: 
Enter an ID associated with the message. 
NOTE: When receiving a text message the radio looks for the message ID and displays the text 
associated with the ID. 
  

The  and  buttons are used to enable/disable additional Text 
Message entries (32 max.). 
    

 
  
These selections determine if a radio can receive and/or send text messages. 
To send or receive Broadcast messages, the corresponding Send or Receive Text Messages box 
must be checked. 
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Conventional System: Data/OTAR  

 
  

 
  
Max Tx Attempts: 
Specifies the number of times the radio attempts to send confirmed data before the attempt is 
considered a failure and ends. (non-registration) 
  
Time Between Attempts: 
Specifies the time that the radio waits before attempting to resend a confirmed data packet. 
  
OTAR Enable: 
Select to enable OTAR (Over the Air Rekeying) of encryption keys on a conventional digital 
system. 
  
Rekey Request Timeout: 
When rekeying is initiated by the radio (Rekey Request message) this setting determines the 
maximum length of time the radio will wait for the Rekey Request procedure to complete. 
Times of 15 to 240 seconds can be programmed. Default is 60 seconds. 
  
Rx Security Level: 

Enhanced: The radio accepts only encrypted and authenticated KMM's from the KMF. 
  
Basic: The radio accepts any KMM that is in a format allowed by the OTAR standard. 

  
Tx Security Level: 

Enhanced - All OTAR procedures originating from the radio are encrypted and authenticated. 
If they cannot be encrypted and authenticated, the radio does not send the KMM. 
  
Basic - The radio always sends unencrypted KMM's if the OTAR standard allows them to be 
unencrypted and unauthenticated. 
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Tactical Rekey Enable: 
Enables unit-to-unit tactical rekey operation for situations where over-the-air-rekeying is not 
available. 
Must be used in conjunction with an authorized mobile data terminal and keyloader. 
  
Queue Dwell Timer: 
Specifies the amount of time data can stay in the data output queue. 
Times are from 15 to 120 seconds. 
  
Data Registration: 
When enabled, the radio will attempt to data register when a conventional digital channel is 
selected. 
  
Data Scan Hold Timer: 
Sets the amount of time the radio will hold on a data channel after transmitting data. Only 
applicable during scan operation. 
  
System Target Address: 
Specifies the Radio Control Manager used as the target address of Inbound Signaling Packet (ISP) 
transmissions such as status and message events. 
The range is from 000000 to FFFFFF. 
Default is FFFFFC. 
  
Subscriber IP Address: 
Specifies the IP Address to be used by the radio in Tactical OTAR operation. 
  
Radio Inhibit: 
If checked, allows the radio to be disabled over-the-air. 
  
Enable Radio Check: 
If enabled, this allows a console to send a query to a radio to check to see whether it is turned on 
and within range or not. If this option is disabled, the radio will not respond to radio check queries 
from the console. 
  
Auto-Generate IP Address: 
Auto-generates an IP Address for the radio. 
Used in Tactical OTAR operation and must be used in conjunction with the target radio's Auto-
generate Destination IP feature. 
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Conventional System: Phone  

  
  
Allows the use of a phone patch when connected to a subscriber network that supports this feature. 
  

 
  
Enabled: 
When checked, allows phone patch placement to be enabled for specified channels on the system. 
  
DTMF Tone Length: 
The length of time, in milliseconds, of each tone in the phone number. 
  
DTMF Tone Gap: 
The length of time, in milliseconds, between each tone in the phone number. 
  
DTMF Start Tone: 
A two-tone sequence that prepends every phone number 
  
DTMF End Tone: 
A two-tone sequence that appends every phone number. 
  
DTMF Answer Tone: 
A four-tone sequence the subscriber radio will send when answering a call. 
  
Alias: 
A label up to 16 characters used to reference the number 
  
Phone Number: 
A DTMF phone number up to 14 digits. 
 

The  and  buttons are used to add/delete phone number entries 
(100 max). 

 

79 

 



System - P25 Trunking  

P25 Trunking systems can only be programmed by authorized personnel. 
A P25 Trunking System Key file is required to edit setting in a trunked system. 
  

 
  
The System - P25 Trunking tab will display parameters for the highlighted P25 Trunking system. 
The "2" designation to the left of "P25 Trunking" denotes the second system in the file. Each 
system enabled in the file will be assigned an incrementing number. 
The [100] to the right of P25 Trunking is the System ID. This assists when making zone/channel 
assignments. 
  
Each P25 Trunking system will have a general settings section and also the following sub pages: 
Add. Options, Channel IDs, Control Channels, Unit Calls, Talk Groups, Announcement 
Groups, Sites, Data/OTAR, Scan Lists, Preferred Site Lists, Sentinel IDs, User Status, Short 
Msg Update and Interconnect. 
  

 
 

 
P25 Trunking - System Keys  

A P25 Trunking System Key file is required to edit setting in a trunked system. 
System Keys are generated by RELM Wireless and can only be issued to authorized system coordinators. 
  
Storing System Keys 
For best results system key files should be stored in the same folder. 
System key files have a file extension of ".key". 
   
Accessing System Keys 
To load system keys select "System Keys" from the tools menu and choose one of the loading options. 
  

 
  
Select the folder containing the keys and click Enter. 
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P25 Trunking - General  

The P25 Trunking - General page contains parameters which apply to radio operation on the 
highlighted P25 Trunking system. 
  

 
  
Some system lists may not be available depending on your system key. 
If RES does not recognize a system key for the desired system in the "Key" archive the "Critical 
System Lists Locked" message will be displayed above the system tabs. 
  
IDs 
  

 
  
Unit ID: 
The Unit ID identifies a particular radio on the system. Enter the desired unit id (decimal) in this 
box. Unit ID range is from 1 to 16777215. 
  
System ID: The System ID designates the "Home" system to which the radio is restricted. 
The System ID (hex) can only be populated by reading the "system key" values. 
Use the drop down menu to view which system id's are available and select the desired system. 
  
Home WACN: 
The "Home WACN" ID identifies the "Wide Are Communications Network" to which the radio is 
restricted. 
The WACN ID (hex) can only be populated by reading the "system key" values. 
It will automatically be populated when the System ID is selected. 
  
Home RFSS: 
The "Radio Frequency Subsystem" ID designates a zone with in the system. 
Enter the Home RFSS for the zone in which the radio will reside. 
  
Home Site: 
The "Home Site" designates a specific site within an RFSS. 
Enter the Home Site ID for the desired home site. 
  
Registration System ID: 
The system ID the radio uses in registration attempts when the System ID parameter is set to the 
wild-card value (0xFFF). 
If programmed as 0, the radio will use the system ID it receives in over-the-air messages. 
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Time/Timers 

 
Tx Timeout timer: 
The Tx Timeout timer determines how long a radio can continuously transmit on the system before 
it must be dekeyed. 
The radio will emit an alert tone and then stop transmitting. 
The operator must release the PTT before transmissions will again be allowed. 
The default time setting is 60 seconds. 
  
RFSS Response Time: 
The RFSS Response timer determines how long the radio will wait between affiliation attempts on 
an RFSS site. 
The default setting is 775ms. 
  
ISP Retry Counter: 
The ISP Retry Counter determines the maximum number of ISP retries the radio will send when 
trying to gain system access. 
The default setting is 4. 
  
Fade Protect Timer: 
The Fade Protect timer determines the amount of time the radio will wait on a control/voice channel 
after synchronization is lost before attempting to re-sync. 
This allows the radio to recover from momentary loss of sync without performing a full 
resynchronization on the control channel. 
This timer will also affect loss of sync on the active control channel. 
The radio will wait until this timer expires before attempting to locate a control channel with a 
stronger signal. 
  
Inactivity Re-affiliation Timer: 
The Inactivity Re-affiliation timer determines the amount of time that must expire before the radio 
will automatically attempt to re-affiliate on the system. 
The default time is 4 hours. 
  
Slot Time: 
The Slot Time is determined by the microSlot scheme used by the system. 
This setting is system specific. The default setting is 6microSlot. 
  
Call Alert Reset Time: 
Allows call alert to expire after the set time period 
  
Full Spectrum Scan 

 
When enabled, Full Spectrum Scan allows the radio to search its specific band for system control 
channels if none can be found via its Dynamic Site Array or its programmed Control Channel list. 
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Scan Time: 
This setting determines how often the radio will leave an active spectrum scan to check the radio 
control channel list to see if one of the programmed channels can be accessed. 
P25 Trunking Emergency 
  

 
  
This section details the P25 Trunking emergency settings. Upon activating an emergency, these 
settings will determine how the radio will report an emergency situation to the designated 
personnel. 
  
Emergency Alarm: 
This check box enables Emergency Alarm. This feature is special signalling sent on a trunking 
control channel when the emergency button is pressed. 
This alarm will inform a console and other radio users that an emergency situation is occurring. 
  
Retry Counter: 
Determines the number of times the radio attempts to send the emergency bit when an 
acknowledgement has not been received from the console. 
  
Tone on Received Emergency Call: 
With this feature active, a tone will sound when an emergency call is received. 
  
Emergency Call: 
This check box enables Emergency Call. 
When an Emergency call is declared, the radio will display "Emergency" and be assigned a voice 
channel for the emergency traffic. 
The system will designate and hold this voice channel for the duration of the emergency call. 
The system won't release this emergency channel until the Emergency Call system hang timer has 
expired. 
  
Emergency Call Cancel: 
Enabling this check box allows the radio to cancel an Emergency Call. (Harris systems) 
  
Emergency Hot Mic: 
This check box enables the Emergency Hot Mic feature. 
When an Emergency Call has been initiated with the Hot Mic active, the radio will automatically 
transmit the emergency call for the duration of the Hot Mic Tx Period and then de-key. 
  
Hot Mic Tx Period: 
This setting determines the length of time the radio will automatically transmit an emergency call if 
Emergency Hot Mic is enabled. 
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Failsoft 
  

 
  
Failsoft is a condition where the site on which the radio is operating suffers a control channel 
failure. When this occurs the site will revert to basic repeater functionality with no overlying control. 
The repeaters will send out a "Failsoft Tone", which the radios will detect. At this point the radios 
will revert to using their pre-assigned failsoft frequency pair. 
This allows limited communication until the controller is brought back on line. 
  
Inactivity Timer: 
This setting will determine how often the radio will initiate a control channel search in an effort to 
find a recently reactivated control channel, or to find an active wide area site that it might move too. 
  
Failsoft Key: 
Sets the encryption key SLN location to use during Failsoft. 
  
Failsoft By Personality: 
Scans the last active control channel and the control channel list for failsoft activity. Once detected, 
the radio will use the active failsoft channel. 
  
Emergency Blocked: 
With this feature active, no emergency mode communication will be allowed when the radio is in 
failsoft mode. 
  
  
Man Down Settings 
  

 
  
Trigger: 

Horizontal - Indicates that Emergency Mode will be triggered after the radio has been horizontal for the specified 
interval. 
  
Horizontal + Motionless - Indicates that Emergency Mode will be triggered after the radio has been horizontal and 
motionless for the specified interval. 

  
Warning Timer: 
Countdown to the warning beep. Indicates the length of time, after meeting the trigger condition, 
before the warning timer begins beeping. 
  
Timer: 
Countdown to Emergency Mode. Indicates the length of time that the warning beep sounds. Once 
these seconds are counted down, Emergency Mode is activated. 
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Additional Options 
  

 
Transmit Power: 
The Transmit Power feature determines what power level the radio is allowed to use when 
transmitting. 
The options for this feature are: 
  

Selectable: The transmit power level can be adjusted using the menu or a function button. 
  
Fixed High: The radio will always transmit using its highest power level. 
  
Fixed Low: the radio will always transmit using its lowest power level. 
  
Automatic: The radio will sense the signal level from its current site and will automatically lower 
or raise its transmit power level based on this reading. 

Signal levels above the signal level threshold will cause the radio to transmit using its 
low power level. 
Signal levels that fall below this threshold will cause the radio to transmit using its 
high power level. 

  
*** Automatic Setting: Sudden signal level shifts may occur (such as entering buildings) which may 
cause momentary system access issues until the radio re-samples the signal levels and adjusts 
the power level accordingly. *** 
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Digital Rx Modulation: 
The Rx Modulation feature allows the radio to adapt its modulation scheme to specific system 
types. 
The options for this feature are: C4FM (non-simulcast) CQPSK (Simulcast) or Both. 
  
PTT Warning Tone Start Time: 
The PTT Warning tone timer determines how long the radio will wait before emitting the Talk 
Prohibit tone 
The default setting is 575ms. 
  
Patch Key: 
The encryption key location used when the radio is involved in a Group Regroup call. (patch call) 
  
Coverage Type: 
Dictates the radio's roaming capabilities. 

Wide Area - The radio will roam system wide, across multiple sites. 

Single Site - The radio will only be able to access a single site. The "Home Site" in the "ID" 
section of the P25 Trunking tab determines the allowed site. 
  

Voice Mute Reset Mode: 
Manual - Once voice mute has been triggered, it will stay disabled until the user manually 
enables it. 
  
Automatic - Once voice mute has been triggered, the voice mute reset timer determines how 
long until voice mute is automatically re-enabled. 
  
Automatic with Carrier - Once voice mute has been triggered, carrier must disappear for the 
duration of the voice mute reset timer before voice mute is automatically re-enabled. 
If carrier returns before the timer expires, the timer will be reset. 

  
Voice Mute Reset Time: 
Timer used in conjunction with the Automatic and Automatic with Carrier Voice Mute Reset Modes. 
  
Conversation Type: 

Message - During hang time, a radio may key up directly on the traffic channel without returning 
to the control channel first. 
  
PTT-ID - During hang time to key up on the active call, the radio must first return to the control 
channel to register its PTT-ID and then can begin transmitting audio. 
  
Transmission - There is no hang time. Once a radio dekeys from its active call, the system de-
allocates the traffic channel. All PTT attempts must request a new channel grant. 
  

Transmit Time: 
The amount of time the unit will transmit after receiving a radio monitor message from the system 
console. 
  
Radio Accountability Tone: 
Allows the user to transmit a pre-programmed set of DTMF digits by pressing and holding the 
"RAT" soft-key. The user can program up to 10 DTMF digits. 
  
Talk Permit Tone: 
Enabling the Talk Permit Tone will cause an alert tone to sound when the system has allocated a 
voice channel grant. 
This allows the operator to know when to begin speaking. Its default condition is on. 
  
Site Trunking Operation: 
Enabling the Site Trunking check box allows the radio to continue to operate on its current site if 
the RFSS (zone) controller fails, which prevents wide are communications. 
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All transmission will be limited to the current site and communications will not be passed to other 
sites. 
If this feature is not enabled the radio will attempt to find a site that still has wide are coverage. 
If unsuccessful, the radio will enter an Out of Range condition until the zone controller has been 
restored and wide are communications are once again allowed. 
  
PTT Warning Tone: 
This tone warns the user that a PTT request to the system is being processed and the user should 
dekey the radio. 
  
Force System Restart: 
Forces the radio to refresh the system information if switching between systems with the same 
System ID/WACN. 
  
Radio Monitor: 
Allows a system console to remotely enable transmit on this unit. 
  
Enhanced Roaming: 
Gives the radio the ability to switch more easily between strong sites. It adds additional thresholds 
so that the radio can react to small signal level changes on strong sites. 
  
Ultra-narrowband Channel Filter: 
Enabled for systems with high adjacent channel interference environments such as simulcast 
systems. Disabled uses a 7.8khz intermediate frequency filter. Enabled uses a 5.76khz filter. 
  
Use System ID For Sites: 
When enabled, it allows users the ability to define sites by a system ID as well as the traditional 
site ID. 
Rx Only: 
Enables a unit to listen to traffic on the corresponding trunking system, but the unit will not be 
allowed to transmit. 
  
  
Dynamic Regrouping: 
Allows Dynamic Regrouping in the selected system. 
  
Dynamic Regrouping Channel Encryption: 
These encryption settings take precedence over talk group level encryption settings or are used to 
set encryption parameters if regrouped to a talk group that is not programmed in the talk group list. 
  
Dynamic Regrouping Key: 
The encryption key location used when the radio is involved in a Dynamic Regrouping call. 
  
  
Unit Call Usage: 
Enabling the Unit Call Usage feature will allow the operator to make Unit-to-Unit calls on the 
system, based on the selected usage settings. 
The options for this feature are: 
  

Disabled - which prevents the user from initiating or receiving any unit calls. 
  
Response Only - which only allows the user to respond to incoming unit calls. 
  
List Only - which allows the user to initiate unit calls only to members or the programmed unit 
call list. 
  
Unlimited - which allows the operator to use direct id entry or the id list to initiate and receive unit 
calls. 

  
Unit Call Type: 
The Unit Call Type selection specifies the type of unit call the radio is allowed to initiate. 
This is usually dependent on system type/programming. 
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P25 Trunking - Channel IDs  

The P25 Trunking - Channel ID page contains channel parameters for the highlighted P25 Trunking 
system.  

 
  
  
Channel ID Table 
  

 
  
The parameters within this table control how the radio decodes Voice and Control channel frequency 
identifiers provided over the air by the system. 
  

The  and  buttons are used to enable/disable additional channel id entries 
(max 16). 
  
Bandwidth (KHz): 
Specifies the channel bandwidth in KHz. 
  
Tx Offset (+/-): 
Specifies whether the Tx frequency is offset positively or negatively from the base frequency. 
  
Tx Offset (MHz): 
Offset from the RX frequency used to derive the TX frequency. 
  
Spacing (KHz): 
Specifies the channel spacing in KHz. 
  
Base Frequency (MHz): 
Specifies the base frequency used to determine all channel calculations for this channel split. 
  
System Type: 
Details the traffic channel protocol the system uses on channels defined by the table entry. 
FDMA = Frequency Division Multiple Access. TDMA = Time Division Multiple Access. 
The radio's ability to use the designated protocol is radio option dependent. 
*** Channel ID table parameters must match system programming. Contact the System Administrator for 
the correct Channel ID table information. *** 
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P25 Trunking - Control Channels  

The P25 Trunking - Control Channels page is used to designate control channels on the 
highlighted P25 Trunking system. 
 

 
  
 
Control Channel Table 
  

 
  
This table is used as a reference by the radio to find control channels upon power up. 
  
Rx Frequency (MHz): 
The receive frequency of the control channel pair. 
  
Tx Frequency (MHz): 
The transmit frequency of the control channel pair. 
  

The  and  buttons are used to enable/disable additional control 
channel entries (max 256). 
  
*** The control channel frequency pairs in this chart are shown from the subscriber viewpoint. 
When referencing control channel frequencies from the system view point, the transmit and receive 
frequencies are inverted. *** 
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P25 Trunking - Unit Calls  

The P25 Trunking - Unit Calls page contains parameters for allowed Unit calls in the highlighted 
P25 Trunking system. 
  

 
  
Unit Call Table 
  

 
  
Entries in this table will be assigned to the Unit Call list and be accessible to the user via the Unit 
Call/Call Alert menu or function buttons. 
Rx ID and Unit Calls received from id's populated on this table will then be displayed as the 
assigned Label instead of the actual unit id number. 
The Unit Call Key selects the SLN used to encrypt Unit-to-Unit calls. 
  

The  and  buttons are used to enable/disable additional Unit ID 
entries (max 1024). 
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P25 Trunking - Talk Groups  

The P25 Trunking - Talk Groups page contains talk group parameters for the highlighted P25 
Trunking system.  

 
  
Talk Group Table 
  

 
  
Talk groups enabled for assignment to specific channel locations are entered in this table. 
Once populated, these talk groups will appear in the Talk Group drop down menu on each trunking 
channel page. 
  
Category 1-4: Partitioned talk groups for ease of access while programming. 
  
Alias: The Label assigned to the specific talk group id. 
  
ID: Actual talk group id (decimal). 
  
Receive Only: Allows talk group to be set to receive only. 
  
Key: The SLN location of the encryption key assigned to this talk group. 
  
Encryption Strapping: Determines the encryption strapping assigned to this talk group. The 
options are Clear, Secure or Selectable via the menu or a function button. 
  
Preferred Site: Allows a site preference to be assigned to this talk group from the "Sites" table. 
  
Failsoft Enabled: The radio will be able to operate under a system Failsoft condition when enabled. 

Failsoft Rx Frequency: The receive frequency used in failsoft mode. 
Failsoft Tx Frequency: The transmit frequency used in failsoft mode. 
  

The  and  buttons are used to enable/disable additional talk group 
entries (max 8192). 
  
Show All: When active, all talk groups (across categories) are displayed regardless of which 
category is selected. 
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P25 Trunking - Announcement Groups  

The P25 Trunking - Announcement Groups tab is used to edit announcement group information 
for the highlighted P25 Trunking system.  
 

 
  
Announcement Group Table 
  

 
  
Announcement groups enabled for assignment to specific channel locations are entered in this 
table. 
Once populated, these announcement groups will appear in the Announcement Group drop down 
menu on each trunking channel page. 
  
Alias: 
The Label assigned to a specific announcement group id. 
  
ID: 
Actual announcement group id (decimal). 
  
Receive Only: 
Enables the Announcement Group as receive only. 
  
Key: 
The SLN location of the encryption key assigned to this announcement group. 
  
Encryption Strapping: 
Determines the encryption strapping assigned to this announcement group. 
Options are: Clear, Secure or Selectable via the menu or a function button. 
  
Preferred Site: 
Allows a site preference to be assigned to this announcement group from the "Site" table. 
  
Selected Ann. Group TG List: 
This list allows the selection of specific talk groups to be designated as sub-members of this 
announcement group. 
  

The  and  buttons are used to enable/disable additional 
announcement group entries (max 8192). 
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P25 Trunking - Sites  

The P25 Trunking - Sites tab contains repeater site parameters for the highlighted P25 Trunking 
system. 
  

 
  
  
Site Table 
  

 
  
Use System ID for Sites: 
When active, the radio uses the System ID along with the RFSS and Site ID when making roaming 
decisions. 
  
Sites entered into this table can be assigned Labels and can also be assigned as preferred sites to 
talk and announcement groups. 
Site Labels will also be visible when making selections from the Site Display, Site Search and Site 
Lock menu or function button items. 
  
Alias: 
The Label assigned to a specific site id. 
  
RFSS ID: 
The RFSS (zone) to which the specified site is assigned. 
  
Site ID: 
Actual site id. 
  

The  and  buttons are used to enable/disable additional site entries 
(max 512). 
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P25 Trunking - Data/OTAR  

The P25 Trunking - Data/OTAR page is used to set data and over-the-air-rekeying on the 
highlighted P25 Trunking system. 
  

 
  
Confirmed Data 
  

 
  
Max Tx Attempts: 
Specifies the number of times the radio attempts to send confirmed data before the attempt is considered a failure and 
ends. (non-registration) 
  
Time Between Attempts: 
Specifies the time that the radio waits before attempting to resend a confirmed data packet. 
  
  
  
OTAR 
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OTAR Enable: 
Select to enable OTAR (Over the Air Rekeying) of encryption keys on the P25 Trunking system. 
  
OTAR Deregistration: 
When enabled the radio will deregister when switching from one system to another. 
  
Rekey Request Timeout: 
When rekeying is initiated by the radio (Rekey Request message) this setting determines the maximum length of time 
the radio will wait for the Rekey Request procedure to complete. 
Times of 15 to 240 seconds can be programmed. Default is 60 seconds. 
  
Rx Security Level: 
Set the receive security setting for OTAR operations. 

Enhanced: The radio accepts only encrypted and authenticated KMM's from the KMF. 
Basic: The radio accepts any KMM that is in a format allowed by the OTAR standard. 

  
Tx Security Level: 
Set the transmit security setting for OTAR operations. 

Enhanced: All OTAR procedures originating from the radio are encrypted and authenticated. 
If they cannot be encrypted and authenticated, the radio does not send the KMM. 

Basic: The radio always sends unencrypted KMM's if the OTAR standard allows them to be unencrypted and 
unauthenticated. 

  
  
  
Network Settings 
  

 
  
KMF IP Address: 
The KMF's IP address. 
  
KMF UDP Port: 
The UDP port the radio uses when it sends KMM's to the KMF. 
The default value is 64414. 
  
Subscriber UDP Port: 
The UDP port the radio uses for OTAR. 
The default value is 64414. 
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Location Services 
  

 
  
Services Enabled: 
Select to enable location services on the P25 Trunking system. 
  
Server IP Address: 
The IP Address of the Location Service server. 
  
Services UDP Port: 
The UDP Port the radio uses when it contacts the Location Service. 
  
Text Messaging: 
  

 
  
Messaging Enabled: 
Enables text messaging for the radio. 
Messaging UDP Port: 
Sets the specific UDP port to use for the messaging. 
 
Other Data Settings 
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Voice Interrupts Data: 
When enabled, a voice call will interrupt the data activity, including OTAR. 
  
Voice Interrupts Data Holdoff Timer: 
Determines the amount of time the radio will remain on the voice channel before attempting to return to the data 
channel after voice traffic had interrupted an active data event. 
  
Queue Dwell Timer: 
Specifies the amount of time data can stay in the SNDCP output queue. 
Settings are from 15 to 120 seconds. Default setting is 60 seconds. 
  
SNDCP Registration: 
If enabled, the radio will attempt to activate an SNCDP context after it registers with the system. 
  
SNDCP Version: 
The SNDCP protocol version used by the radio when communicating with the system. 
  
Registration Type: 
Selects what type of IP addressing the radio will use. 
  

Dynamic - If the system will provide the subscriber IP address if the radio requests dynamic registration. 
  
Static - If the radio subscriber has been configured with a static IP address. 

  
Subscriber IP Address: 
Enter the radio's static IP address here. 
  
OTAP Enabled: 
Enables over-the-air radio programming. 
  
OTAP UDP Port: 
The UDP port the radio uses for OTAP. 
The default value is 64414. 
  
Allow Keyset Selection: 
Allow radio use to select encryption keysets. 
  
Authentication Timeout: 
The period of time allowed before the subscriber unit determines that the authentication process (if enabled) has 
failed. 
  
Force Mutual Authentication: 
Select if the infrastructure supports mutual authentication. 
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P25 Trunking - Scan Lists  

The P25 Trunking - Scan Lists page is used to setup scan lists for the highlighted P25 Trunking 
system. 
  

 
  
Scan Lists 
  

 
  
This list displays the all active scan lists. 
  

The  and  buttons are used to enable/disable scan 
lists (max 255). 
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General Settings 
  

 
  
Scan Hold Time: 
This setting determines the amount of time the radio will wait on the active voice channel after 
ending a call before returning to control channel. 
This time is cumulative to any programmed "system" hang time. 
  
Beep on Pri Rx: 
Indicates that a beep will sound when Priority 1 channel becomes active. 
  
Priority Type: 
This setting determines the Priority setting of the selected scan list. 
There are three options. 
  

Priority: This scan list will allow designation of up to two priority talk group/channel locations. 
  
Priority 1 on Selected: This scan list will use the currently selected talk group/channel location as 
the Priority 1 selection. A "fixed" Priority 2 talk group/channel location can also be designated 
  
Non Priority: A scan list designated as Non Priority will have no priority talk group/channel 
locations. 

  
Talk Back Type: 
The Talk Back Type setting will determine how the radio response to voice traffic. 
  

Selected: This setting forces the radio to always respond to active scan traffic on its selected 
talk group/channel location. 
  
Active: This setting allows the radio to respond to scan traffic on the active talk group/channel 
location. 
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Channel List 
  

 
  
Zone: 
Select the desired Zone from its drop down menu. Only Zones with active P25 channel locations 
will appear in the Zone list. 
  
Channel: 
Select the desired channel location from its drop down menu. Only P25 Trunking designated 
channels will appear in the Channel list. 
  
Priority Channels Selection: 
Only one channel each can be designated as Priority 1 and Priority 2 channels. 
  

The  and  buttons are used to add/delete the scan list channel 
entries (max 16). 
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P25 Trunking - Preferred Site Lists  

The P25 Trunking - Preferred Site Lists page is used to setup preferred site lists for the 
highlighted P25 Trunking system. 
  

 
  
Preferred Sites Lists 
  

 
  
This list displays the all active preferred sites lists. 
  

The  and  buttons are used to enable/disable 
preferred sites lists (max 255). 
  
Site Table 

 
  
RFSS ID: 
The RFSS (zone) to which the specified site is assigned. 
  
Site ID: 
Actual site id. 
  
Site Preference: 
Details the roaming rank weighting added or subtracted to particular site to affect the radio's us of 

that site. 

None - No additional weighting is added/subtracted to the site. 

Least - Rank weighting is subtracted from this site so that other sites are ranked above it for use. 

Preferred - Substantial rank weighting is added to the site so that it is preferred for use above all 

other sites. 

Always - The rank weighting added is so high that the radio will always use this site unless it is 
unavailable. 
  

The  and  buttons are used to enable/disable additional site entries 
(max 16). 
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P25 Trunking - Sentinel IDs  

The P25 Trunking - Sentinel IDs page is used to setup Sentinel IDs for the highlighted P25 
Trunking system. 
  

 
  
  
  
Sentinel ID Table 
  

 
  
Sentinel operation allows the radio to perform certain functions after receiving a call alert to a 
programmed unit ID. 
  
ID: 
The unit ID at which the radio will monitor for call alerts. 
  
DTMF ID: 
Upon receiving a call alert to the corresponding unit ID the radio will immediately transmit these 
DTMF digits. 
  
Acc Output: 
Used with the mobile I/O binary mode. Upon receiving a call alert to the corresponding unit ID the 
radio will enable the accessory output lines corresponding to the programmed accessory output 
value. 
  
DTMF Output: 
Whether or not the mobile unit will send the DTMF digits after receiving a call alert to the 
corresponding unit ID. 
  

 and  buttons are used to enable/disable additional Sentinel id 
entries. Multiple sentinel IDs can be programmed, each with their own functions (max 32). 
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P25 Trunking - User Status  

The P25 Trunking - User Status page is used to setup user statuses for the highlighted P25 
Trunking system. 
  

 
  
  
  
User Status ID Table 
  

 
  
Status updates are short numeric identifiers with corresponding status aliases that represent the 
status of the source unit. 
  
Alias, ID: 
The status alias and its corresponding identifier. When a radio receives a status update with this ID 
the alias will be displayed on the screen. 
  

The  and  buttons are used to enable/disable additional Sentinel id 
entries. Up to 255 aliases can be programmed into the radio (max 255). 
  
  
Options: 
  

 
  
Single Destination: 
When enabled the user does not specify the destination unit on-screen. The status update is 
automatically sent to the corresponding destination ID. 
  
Destination ID: 
The P25 destination ID to which status updates can be automatically sent to. 
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P25 Trunking - Short Msg Update  

The P25 Trunking - Short Msg Update page is used to setup short message updates for the 
highlighted P25 Trunking system. 
  

 
  
Short Msg Update Table 
  

 
  
Message updates, similar to status updates, are short numeric identifiers  with corresponding 
message aliases that represent short forms of text communications. 
  
Alias, ID: 
The message alias and its corresponding identifier. When a radio receives a message update with 
this ID the alias will be displayed on the screen. 
  

The  and  buttons are used to enable/disable additional Sentinel id 
entries. Up to 255 aliases can be programmed into the radio (max 255). 
  
Options: 
  

 
  
Single Destination: 
When enabled, the user does not specify the destination unit on-screen. The message update is 
automatically sent to the corresponding destination ID. 
  
Destination ID: 
The P25 destination ID to which message updates can be automatically sent to. 
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P25 Trunking - Interconnect  

The P25 Trunking - Interconnect page is used to setup the trunking interconnect feature for the 
highlighted P25 Trunking system. 

 
  
  

 
  
  
Interconnect Short Form Table 
The short form table is similar to a speed dial of sorts. Sending a PSTN (Public Switched 
Telephone Network) value to the system will cause it to dial a phone number attached to that value. 
  
Interconnect Long Form Table 
The long form table is more straight forward. It contains a list of phone numbers. Users can send 
these phone numbers to the system to call that phone number. 
  
Interconnect Options 
  

 
  
Usage: 
The interconnect usage can be Disabled, Answer Only, Short List Only, Lists Only or Unlimited. 
  
Key: 
The interconnect key from 1-64. 
  
Active Dial: 
The interconnect active dial can be either Live of Buffered. 
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Max List Entries 
 
List Sizes  

Maximum List Sizes 
Each list has a maximum number of entries that may be added. 
  
Convention System Lists 
List Name Max Entries 
User ID Alias List 512 
CxCSS Picklist 256 
NAC Picklist 32 
Talkgroup PickList 32 
Two-Tone List 100 
DTMF List 100 
MDC List 512 
Five-Tone List 100 
User Status 256 
Text Messages 32 
Phone 100 
  
  
Trunking System Lists 
List Name Max Entries 
Channel IDs 16 
Control Channels 256 
Unit Calls 1024 
Talk Groups 8192 
Announcement 
Groups 

8192 

Sites 512 
Scan Lists 255 
Scan List Entry 16 
Preferred Site Lists 255 
Preferred Site List 
Entry 

16 

Sentinel IDs 32 
User Status 255 
Short Message 
Update 

255 
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Zones & Channels  

The Zone tab allows the programming of specific zones and channels. 
  

 
  
The drop-down menu contains active zones. Zones can be added and deleted from this list by clicking the +Z button to 
add or the -Z button to delete. 
  
Channel View 
Channels may be viewed and edited in Single Channel or Multi-Channel viewing mode. 
The Channel View can be changed under View -> Channel View Selection. 
  

 
  
  
Multi-Channel View 
In Multi-Channel View, Zone Settings appear at the top of the window. 
Each channel is displayed as a row in the channels table. 
  

 
  
  
Single Channel View 
In Single Channel View, Zone settings are viewed by selecting the desired zone from the drop-down menu and clicking 
the Zone Settings tab. 
Individual channels are viewed by selecting the desired zone from the drop-down menu and the specific channel from 
the left window. 
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Multi-Channel View  

Channel View 
Channels may be viewed and edited in Single Channel or Multi-Channel viewing mode. 
The Channel View can be changed under View -> Channel View Selection. 
  

 
  
Multi-Channel View 
In Multi-Channel View, Zone Settings appear at the top of the window. 
Each channel is displayed as a row in the channels table. 
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Zone Settings  

In the left pane, select the zone to be edited from the drop-down menu. 
  

 
  
Zone settings 
  

 
  
  

 
  
  
Identification 
  
Alias: 
Label for the selected zone can be entered in the Alias box. 
This entry will also be displayed directly above the General tab when in Single Channel view. 
  
Voice Annunciation: 
Enables voice annunciation of selected zone. 
  
Zone Index: Sets the index of the zone. 
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Priority Options (Zone Priority Scan) 
  

 
  
In each zone, up to two channels can be designated a priority channels. 
In Priority Scan mode, these two channels (Pri 1 & Pri 2) are periodically checked for activity, even 
if non-priority traffic is currently being monitored. 
Activity on Pi 2 preempts activity on any of the non-priority channels. 
Activity on Pri 1 has priority over any other channel in the zone, including Pri 2. 
Priority Scan is automatically disabled when Zone Scan is active. 
  
Use the drop down box to assign the Pri 1 and Pri 2 channels. Priority operation can be 
enabled/disabled via the menu or a function button. 
  
Priority 1 Selection: Select the Priority 1 channel from the drop down menu. 
  
Priority 2 Selection: Select the Priority 2 channel from the drop down menu. 
  
Priority Transmissions: If the radio is programmed to Transmit on Priority 1, transmissions will 
occur on the Pri 1 channel when Priority Scan mode is active. 
  
*** Zone Priority settings are overridden by System Priority settings. *** 
  
Vote Scan Options 
  

 
  
Initial Vote - Carrier Only: 
When active, upon radio power, the initial vote will be determined by using carrier signal strength 
only. 
  
Fast Vote: 
When active, if the signal level for the current repeater is above the RSSI threshold, no additional 
voting will occur and the current repeater will be used. 
  
Vote Carrier Only: 
When active, all voting will be based on carrier signal level only. 
  
Display Selected Channel Only: 
When active the radio will always display the selected channel instead of the repeater channel 
used once it has voted. 
  
Tx On Last Voted Channel: 
Causes the radio to transmit on the last voted channel, regardless of scan hold status or talkback 
scan setting. 
  
Automatic Vote Scan: 
Selection of a vote scan channel activates vote scan, without user interaction. 
  
Post-Tx Revote: 
Forces a revote at the end of transmission on vote scan channels, instead of waiting for a carrier 
dropout to revote. 
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Other Settings 
  

 
 
Allow CxCSS Selection On All Channels 
If checked, tone selection is available on all analog and/or mixed mode channels. 
  
If unchecked, only channels with no programmed tone (000.0) are available for tone selection. 
  
Disable Keypad Programming: 
With this check box enabled, the radio will not allow Keypad Programming in the highlighted zone. 
  
Command Zone: 
Designates the current zone as a Command Zone. 
Channels can be added or deleted to command zone during normal radio operation. 
Refer to the radio user's manual for operation details. 
  
Zone Scan: 
Enable the check box to add the currently highlighted zone to the Zone Scan List. 
  
Incoming Clone: 
Each zone can be blocked from receiving clone information from a "Master" radio. 
Use the drop down menu to allow or reject incoming cloning. 
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Channels - Conventional  

Conventional Channels include the following settings: 
 
System 

 

 
 
 
 
By highlighting the channel type, a drop down menu will appear that allows the channel to 
be associated with one of the active systems within the file. 
  
The "Conv (1)" shows that the channel is associated with System 1. 

  
Label 

 

 
 
 
The radio can be programmed with an Label for each channel within a zone. 
Each label can include up to 13 characters. 
Characters can include A-Z, 0-9 or a blank space. 

  
Voice Annunciation 
  

 

 
 
 
 
 
 
 
 
This allows you to select what voice you wish to play when that channel is 
selected. Note: These are AMBE files, for further information on how to convert 
and load Voice Annunciation files, go to the Audio Converter Help Docs 
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Rx Frequency 

 

 
 
 
 
Enter a Valid receive frequency. 
This entry must match the default band of the file. 

  
Rx Mode 

 

 
 
 
 
 
Select Analog, Digital or Mixed mode from the drop down menu. 

  
Rx Code Guard 

 

 
 
Analog channels can use sub-audible signaling to allow one radio or a group 
of radios to be selectively called within a system. 
  
CTCSS: Select the desired signaling tone via the drop down menu.(67.0 - 
254.1hz) 
CDCSS: Select the desired signaling code via the drop down menu.(023 - 
754) 
Carrier/Noise Squelch: For carrier or noise squelch, select None. 

  
Rx Code Guard Index 

 

 
 
 
 
 
 
 
Select the index of the desired code guard 
on the CxCSS Picklist. 
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Rx NAC 

 

Each Digital or Mixed Mode channel is programmed with a receive NAC. When an 
incoming signal's NAC matches the channel's programmed receive NAC, the radio 
unmutes. 
  
Range:0 – FFF 
  
The digital equivalent of carrier squelch is achieved by programming the receive NAC = 
F7E (3966 Decimal); the radio will unmute when a digital signal with any NAC is 
detected. 
  

  
Rx NAC Index 

 

 
 
 
 
Select the index of the desired NAC 
on the NAC Picklist. 

  
Rx CG Invert 

 

 
 
 
 
 
Inverts the receive code guard on the given channel. 

  
Tx Frequency 

 

 
 
 
 
Enter a Valid receive frequency. 
This entry must match the default band of the file. 
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TX Mode 

 

 
 
 
 
 
Select Analog, Digital or Mixed mode from the drop down menu. 

  
Tx Code Guard 

 

 
 
Analog channels can use sub-audible signaling to allow one radio or a group 
of radios to be selectively called within a system. 
  
CTCSS: Select the desired signaling tone via the drop down menu.(67.0 - 
254.1hz) 
CDCSS: Select the desired signaling code via the drop down menu.(023 - 
754) 
Carrier/Noise Squelch: For carrier or noise squelch, select None. 
  

  
Tx CG Index 

 

 
 
 
 
 
Select the index of the desired code guard on 
the CxCSS Picklist. 
  

  
Tx NAC 

 

 
 
 
Each Digital or Mixed Mode channel is programmed with a receive NAC. When an 
incoming signal's NAC matches the channel's programmed receive NAC, the radio 
unmutes. 
  
Range:0 – FFF 
The F7E NAC is reserved for receivers and is not allowed as a transmit NAC. 
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Tx NAC Index 

 

 
 
 
 
Select the index of the desired NAC 
on the NAC Picklist. 
  

  
Tx CG Invert 

 

 
 
 
 
 
Inverts the transmit code guard on the given channel. 

  
ANI Type 

 

 
 
 
 
Specifies the format of the ANI (Automatic Number Identification) signal to be 
transmitted. 
  

  
ANI Mode 

 

 
 
 
 
 
Specifies when the ANI code is transmitted. 
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ANI Index 

 

 
 
 
 
This selection is used in conjunction with ANI Type, and specifies the content of 
the ANI signal. The index values are listed in the corresponding tab of the 
System Conventional page. 
  

  
DTMF Live Dial 

 

 
 
 
 
 
Enables the keypad to be used to transmit DTMF tones. 
  

  
Encryption 

 

 
Select the encryption condition of the channel. 
  
Clear: The channel will always transmit in the clear mode. 
  
Secure: The channel will always transmit in the secure mode. 
  
Selectable: The channel can switched between clear and secure 
modes via the menu or a function button. 
  

  
Key 

 

 
 
 
 
 
Programs the channels encryption key SLN location via the drop down menu. 
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DES-CFB 

 

 
 
 
 
 
Enables DES-CFB analog encryption. Communications will only work with other DES-CFB 
enabled analog channels that have the same key selected. (analog only) 

  
Proper Key Detect 

 

 
 
 
 
 
Used along-side analog DES-CFB. When enabled will cause the radio to 
stay muted when it detects a mismatched key. 
  

  
Key Lock 

 

 
 
 
 
If a new global encryption key is selected via the "Key Pick List" and the "Key Lock" is 
"Yes" for a specific channel, the radio will always transmit on that channel using the 
selected key and will disregard the new global key selection. 

  
Talk Group 

 

 
 
 
 
Enter the desired talk group for the selected channel. 
Talk group ID's from 1 to 65535 are valid. 
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Talk Group Index 

 

 
 
 
 
Select the index of the desired talk group from the talk group 
picklist. 

  
Scan List 

 

 
 
Designates this channel as part of the Channel Scan list. 
  
Off: The channel is not a member of the Channel Scan list. 
  
On: The channel is a member of the Channel Scan list. 
  
Vote: This channel is a member of a Vote Scan list. 
(Vote scan option required) 
  

  
Vote Scan Group 

 

 
 
 
 
 
Denotes which vote-scan group this channel should belong to. Vote scan 
groups allow different sets of channels to be voted without requiring multiple 
zones. 

  
Auto Scan 

 

 
 
 
 
 
Indicates that selection of this channel will initiate channel scan, regardless of the 
toggle switch setting. The toggle switch is still operational. 
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Data Mode 

 

 
 
 
 
Data Modes selections include: 
FNE - Fixed Network Equipment 
Direct - Radio to radio 
Repeated - radio to repeater 

  
OTAR Chan 

 

 
 
 
 
 
Enables OTAR/Data operations on the selected channel. 

  
Digital Squelch 

 

 
Determines the active squelch mode for the selected channel. 
  
Selective: 
All voice traffic must be qualified before the radio will open squelch. 
For digital traffic, the NAC and talk group must be qualified to 
unmute. For analog, CTCSS/CDCSS must be qualified to unmute. 
  
Normal: 
For digital traffic, the NAC must be qualified for the radio to unmute. 
Talk Group will be ignored. Analog traffic will treat this mode the 
same as Selective. 
  

  
Bandwidth 

 

Determines the modulation level for the selected 
channel in analog mode. 
  
Wide: 
Selects Wide Band modulation. (25Khz channel 
spacing ) 
  
Narrow: 
Selects Narrow Band modulation. (12.5Khz channel 
spacing ) 
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Tx Power 

 

 
 
Transmit power level for the selected channel. 
  
Low: The channel will transmit on its lowest power level. 
  
High: The radio will transmit on its highest power level. 
  
Selectable: The radio can be switched between high and low 
power levels via the menu or function button. 
  

  
Busy Condition 

 

Determines the "Busy" condition settings for the selected channel. 
  
Carrier: A busy condition is declared when carrier is present on the selected Rx 
frequency. 
  
Non-Qualified: A busy condition is declared when a non-qualified signal is present 
on the Rx frequency. (No qualified = Incorrect CTCSS/CDCSS, talk group or NAC ) 
  
Status Symbol: A busy condition is declared if a repeater outbound channels busy 
status symbol is present on the Rx frequency. 
  

  
Surveillance 

 

 
The Surveillance drop box allows this channel location to make use of the surveillance 
feature. 
  
Off: Surveillance mode is not enabled on this channel location. 
  
On: Surveillance mode is always enabled for this channel location. 
  
Selectable: Surveillance can be enabled/disabled on this channel location by using the 
menu or function button. 
  

  
Voice Mute Type 

 

Voice Mute will unmute the receiver upon reception of the proper signal. 
  
Two-Tone: Receiver listens for the Two-Tone signal specified by the Voice Mute 
Index. The receiver is muted upon the activation of Voice Mute via menu or 
button. 
  
DTMF: Receiver listens for the DTMF signal specified by the Voice Mute Index. 
The receiver is muted upon the activation of Voice Mute via menu or button. 
  
Five-Tone: Receiver listens for the Five-Tone signal specified by the Voice Mute 
Index. The receiver is muted upon the activation of Voice Mute via menu or 
button. 
  
  
To activate these auto types, check Auto Voice Mute. 
  
Two-Tone Auto: Auto Receiver listens for the Two-Tone signal specified by the 
Voice Mute Index. The receiver is muted upon the selection of the channel. 
  
DTMF Auto: Auto Receiver listens for the DTMF signal specified by the Voice 
Mute Index. The receiver is muted upon the selection of the channel. 
  
Five-Tone Auto: Auto Receiver listens for the Five-Tone signal specified by the 
Voice Mute Index. The receiver is muted upon the selection of the channel. 
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Voice Mute Index 

 

 
 
 
 
This selection is used in conjunction with Voice Mute Type, and specifies the 
content of the Voice Mute signal. The index values are listed in the 
corresponding tab of the System Conventional page. 

  
Phone Patch 

 

Disabled: Phone patch is disabled for this 
channel. 
  
List Only: Phone patch may be invoked by 
selecting an entry from the Phone Number 
List. 
  
List and Keypad: The user may enter a 
number from the keypad to establish a call. 
  
The Phone patch option will be disabled 
unless Phone Patch Enable is checked for 
the System. 

  
 
Hidden 

 

 
 
 
 
Indicates that this channel cannot be selected from the keypad or menu, 
and is not on the list of channel selection choices. It can however be 
selected by the knob if it is one of the first sixteen channels. 

  
Scan Penalization 

 

 
 
 
 
 
 
 
Scan Penalization entails checking the qualification (NAC or Code Guard) of a scanned 
channel only once while another frequency is active. This speeds up scanning, but may 
result in a Priority Channel not becoming active if it qualification changes while another 
frequency is active. Disabling Scan Penalization forces the qualifications to be checked 
every time. 
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Auto Voice Mute 

 

 
 
 
Toggles the auto version of each voice mute mode. For example, if voice mute 
type is set to two-tone, check the auto voice mute option to set it to two-tone 
auto. 
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Channels - P25 Trunking  

P25 Trunking Channels include the following settings: 
System 

 

 
 
 
By highlighting the channel type, a drop down menu will appear that allows the channel to 
be associated with one of the active systems within the file. 
  
The "02 P35 Trunking" shows that the channel is associated with System 2. 

  
Label 

 

 
 
 
Enter the Label to be associated with the talk group assigned to the selected channel 
location. This Label will be displayed in the PTT-ID field when an active call from this 
talk group is received. 

 
Voice Annunciation 

 

 
 
 
 
 
 
 
 
 
The voice annunciation selector determines which voice annunciation file will 
play when the radio switches to this channel. 
  

  
Talk Group 

 

 
 
 
The talk group to be associated with this channel location can be selected via the drop down 
menu. 
The talk groups appearing on this list have been entered in the "Talk Group" list. 
(System tab/P25 Trunking, Talk Group List) 
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Ann. Group 

 

 
 
 
The announcement group to be associated with this channel location can be selected via 
the drop down menu. 
The announcement groups appearing on this list have been entered in the 
"Announcement Group" list. 
(System tab/P25 Trunking, Announcement Group list) 

  
Emergency Group 

 

 
 
 
The emergency group to be associated with this channel location can be selected via 
the drop down menu. 
The emergency groups appearing on this list have been entered in the "Talk Group" list. 
(System tab/P25 Trunking, Talk Group list) 

  
Auto Scan 

 

 
 
 
 
This feature will automatically start Priority Scan whenever this channel is selected. If Auto 
Scan is not enabled, scan is started via a function button or via the menu. 
  

  
Scan List Number 

 

 
 
 
 
This setting determines which scan list will automatically be scan when the feature is active 
on a specific channel. 
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Surveillance 

 

 
 
The Surveillance drop box allows this channel location to make use of the surveillance 
feature. 
  
Off: Surveillance mode is not enabled on this channel location. 
On: Surveillance mode is always enabled for this channel location. 
Selectable: Surveillance can be enabled/disabled on this channel location by using the 
menu or function button. 

  
Dynamic Regrouping 

 

 
 
 
 
 
Allow or block dynamic regrouping on the selected channel. 

  
DTMF ID (Pri) 

 

 
 
 
 
Used in conjunction with Voice Mute. Receiving these DTMF digits will cause voice 
mute to trip. 

  
DTMF ID (Sec) 

 

 
 
 
 
Used in conjunction with Voice Mute. Receiving these DTMF digits will cause 
voice mute to trip. 

 
DTMF Live Dial 

 

 
 
 
 
 
Enables the keypad to be used to transmit DTMF tones. 

 

126 

 



Single Channel View  

Channel View 
Channels may be viewed and edited in Single Channel or Multi-Channel viewing mode. 
The Channel View can be changed under View -> Channel View Selection. 
  

 
  
  
Single Channel View 
In Single Channel View, Zone Settings appear at the top of the window. 
Each channel is displayed as a row in the channels table. 
  

 
  
The Zone Settings tab contains zone specific settings. 
The drop-down list displays active zones. Zones can be added and deleted from this list using the +Z and -Z buttons. 
The left pane displays active channels within the selected zone. 
Channels can be added, deleted and set to a specific system type in this pane. 
The Channel Settings tab displays the parameters for the selected channel. 
  
  

-+ 
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Zones Settings  

Zones 
  

 
  
Zone Settings 
Selecting the Zone tab will display the Zone General page. 
The left pane shows the active zones. 
A right mouse click in the left pane will bring up a drop down menu. The options for this menu are: Add 
Zone, Delete, Cut, Copy and Paste. 
  
Single Channel View 
  
The right pane displays the General parameters to be programmed for the zone highlighted in the left 
pane. The selected zone Label is also detailed directly above the General tab. 
  

 
  
The zone settings tab has been moved to the Zone Settings Window. 
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Identification 
  

 
  
Alias: 
Label for the selected zone can be entered in the Alias box. 
This entry will also be displayed directly above the General tab when in Single Channel view. 
  
  
Priority Options (Zone Priority Scan) 
  

 
  
  
In each zone, up to two channels can be designated a priority channels. 
In Priority Scan mode, these two channels (Pri 1 & Pri 2) are periodically checked for activity, even if 
non-priority traffic is currently being monitored. 
Activity on Pi 2 preempts activity on any of the non-priority channels. 
Activity on Pri 1 has priority over any other channel in the zone, including Pri 2. 
Priority Scan is automatically disabled when Zone Scan is active. 
  
Use the drop down box to assign the Pri 1 and Pri 2 channels. Priority operation can be 
enabled/disabled via the menu or a function button. 
  
Priority 1 Selection: Select the Priority 1 channel from the drop down menu. 
  
Priority 2 Selection: Select the Priority 2 channel from the drop down menu. 
  
Priority Transmissions: If the radio is programmed to Transmit on Priority 1, transmissions will occur 
on the Pri 1 channel when Priority Scan mode is active. 
  
*** Zone Priority settings are overridden by System Priority settings. *** 
  
 
Vote Scan Options 
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Initial Vote - Carrier Only: 
When active, upon radio power, the initial vote will be determined by using carrier signal strength only. 
  
Fast Vote: 
When active, if the signal level for the current repeater is above the RSSI threshold, no additional voting 
will occur and the current repeater will be used. 
  
Vote Carrier Only: 
When active, all voting will be based on carrier signal level only. 
  
Display Selected Channel Only: 
When active the radio will always display the selected channel instead of the repeater channel used 
once it has voted. 
  
Tx On Last Voted Channel: 
Causes the radio to transmit on the last voted channel, regardless of scan hold status or talkback scan 
setting. 
  
Automatic Vote Scan: 
Selection of a vote scan channel activates vote scan, without user interaction. 
  
Post-Tx Revote: 
Forces a revote at the end of transmission on vote scan channels, instead of waiting for a carrier 
dropout to revote. 
  
  
Other Settings 
  

 
  
Zone Scan: 
Enable the check box to add the currently highlighted zone to the Zone Scan List. 
  
Disable Keypad Programming: 
With this check box enabled, the radio will not allow Keypad Programming in the highlighted zone. 
  
Command Zone: 
Designates the current zone as a Command Zone. 
Channels can be added or deleted to command zone during normal radio operation. 
Refer to the radio user's manual for operation details. 
  
User-Selectable Tx Tones: 
Enabling this allows a user to change their code guard from the picklist (for all channels in the zone). 
  
Incoming Clone: 
Each zone can be blocked from receiving clone information from a "Master" radio. 
Use the drop down menu to allow or reject incoming cloning. 
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Channel Settings      

Channels 
The Channel Settings page allows the user to add and delete channels and edit their functional parameters. 
  

 
  
On the left-hand side of the window, there is the channels list. At the bottom of the channels list are four buttons. 
  

 
  
+CC Green Adds a conventional channel to the selected zone. 
+TC Blue Adds a trunking channel to the selected zone. (There must be       

add a trunking channel.) 
+/-C Red Opens the Multi-Channel Add and Edit List interface. Allows th       

multiple channels at once. 
-C Orange Deletes the selected channel. 
  
  
Multi Channel Add and Edit List 
  

 
  
To add multiple channels, first select the desired system for the new channels. Clicking the drop-down menu will list the system  
  

 
  
Type in the specific channels to be added separated by commas and ranges of channels to be added separated by dashes. Fo   
to add channels 2, 4, and every channel from 6 to 13, type 2, 4, 6-13 
  
Deleting channels uses the same formatting as adding channels, but it doesn't matter what system is selected. Even with a con     
channel 7 is a trunking channel 
and the interface is told to delete channel 7, it will still delete it. 
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Channels - Conventional  

Highlighting the desired conventional channel allows access the General tab. All conventional channel specific 
parameters are programmed on this tab. 
  

 
  
  
Identification 
  

 
  
Channel Alias: 
The radio can be programmed with a Label for each channel within a zone. 
  
Each label can include up to 13 characters. Characters can include A-Z, 0-9 or a blank space. 
The programmed Label will also display in the channel list under the "Alias" column. 
  
Voice Annunciation: 
The voice annunciation selector determines which voice annunciation file will play when the radio switches to this 
channel. 
  
  
Security (Digital/Mixed Mode channels only) 
  

 
  
These settings determine the encryption functionality for each channel location. 
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Encryption: 
Select the encryption strapping condition of the channel. Available options are: 

Clear: The channel will always transmit in the clear mode. 

Secure: The channel will always transmit in the secure mode. 

Selectable: The channel can switched between clear and secure modes via the menu or a function button. 

  
Key: 
Programs the channels encryption key SLN location via the drop down menu. 
  
Key Lock: 
Disallows encryption key picklist selection for the selected channel. 
  
DES-CFB: 
Enables DES-CFB analog encryption. Communications will only work with other DES-CFB enabled analog channels 
that have the same key selected. (analog only) 
  
Proper Key Detect: 
Used along-side analog DES-CFB. When enabled will cause the radio to stay muted when it detects a mismatched 
key. 
  
  
Scan 

 
Scan: 
Designates this channel as part of the Channel Scan list. 
  

Off: The channel is not a member of the Channel Scan list. 
  
On: The channel is a member of the Channel Scan list. 
  
Vote: This channel is a member of a Vote Scan list. (Vote scan option required) 

  
Enable Autoscan: 
Indicates that selection of this channel will initiate channel scan, regardless of the toggle switch setting. The toggle 
switch is still operational. 
  
Vote Scan Group: 
Denotes which vote-scan group this channel should belong to. Vote scan groups allow different sets of channels to be 
voted without requiring multiple zones. 
  
Disable Channel Scan Penalization: 
Scan Penalization entails checking the qualification (NAC or Code Guard) of a scanned channel only once while 
another frequency is active. 
This speeds up scanning, but may result in a Priority Channel not becoming active if it qualification changes while 
another frequency is active. Disabling Scan Penalization forces the qualifications to be checked every time. 
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Data 
 

 
 
Data Mode: 
Data Modes selections include: 
  

FNE - Fixed Network Equipment 
  
Direct - Radio to radio 
  
Repeated - radio to repeater 

  
OTAR/Data Enabled: 
Enables OTAR/Data operations on the selected channel. 
  
  
Receive Options 
 

 
  
Receive Frequency: 
Enter a Valid receive frequency. This entry must match the default band of the file. 
  
Receive Mode: 
Select Analog, Digital or Mixed mode from the drop down menu 
  
Receive Code Guard (CxCSS): 
Analog and Mixed Mode channels can use sub-audible signaling to allow one radio or a group of radios to be 
selectively called within a system. 

CTCSS: Select the desired signaling tone via the drop down menu. (67.0 - 254.1hz) 
CDCSS: Select the desired signaling code via the drop down menu. (023 - 754) 
None: Carrier/Noise Squelch. 

  
NAC: 
Each Digital or Mixed Mode channel is programmed with a receive NAC. When an incoming signal's NAC matches the 
channel's programmed receive NAC, the radio unmutes. 
Range:0 – FFF 
The digital equivalent of carrier squelch is achieved by programming the receive NAC = F7E (3966 Decimal); the radio 
will unmute when a digital signal with any NAC is detected. 
The NAC label will show whether it is in hexadecimal or decimal mode. This setting can be changed under by clicking 
options in the menu bar and then toggling "Show NACs as Hex". 
  
Squelch Adjust: 
Sets the default level when new channels are created in keypad programming. 
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Squelch Operation: 
Determines the active squelch mode for the selected channel. 
  

Selective: All voice traffic must be qualified before the radio will open squelch. For digital traffic, the NAC and talk 
group must be qualified to unmute. For analog, CTCSS/CDCSS must be qualified to unmute. 
  
Normal: For digital traffic, the NAC must be qualified for the radio to unmute. Talk Group will be ignored. Analog 
traffic will treat this mode the same as Selective. 

  
Code Guard (CxCSS) Index: 
When a Code Guard Index is selected, the channel will use the Code Guard from the associated picklist at initial 
power-up. 
If a new Code Guard is selected during radio operation, this field shows the currently selected Code Guard when the 
radio is read. 
  
NOTE: "Code Guard Index" must be checked in order to select this field. 
  
NAC Index: 
When a NAC Index is selected, the channel will use the NAC from the associated picklist at initial power-up. 
If a new NAC is selected during radio operation, this field shows the currently selected NAC when the radio is read. 
  
Invert DCS: 
Select to invert a DCS Code Guard. 
  
Receive Only: 
If enabled, the transmit mode will be disabled on this channel location. 
The radio will display "Rx Only" and sound an alert tone if PTT is pressed. 
  
  
Transmit Options 
  

 
  
Transmit Frequency: 
Enter a valid transmit frequency. This entry must match the default band of the file. 
  
Busy Condition: 
Determines the "Busy" condition settings for the selected digital channel. 
  

Carrier: A busy condition is declared when carrier is present on the selected Rx frequency. 
  
Non-Qualified: A busy condition is declared when a non-qualified signal is present on the Rx frequency. (No 
qualified = Incorrect talk group or NAC ) 
  
Status Symbol: A busy condition is declared if a repeater outbound channels busy status symbol is present on the 
Rx frequency. 
  
Correct NAC: A busy condition is declared when receiving digital signal with the correct NAC, and declared not busy 
under all other conditions. 

  
Transmit Mode: 
Select Analog, Digital or Mixed mode from the drop down menu. 
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Tx Power: 
Transmit power level for the selected channel. 
  

Low: The channel will transmit on its lowest power level. 
  
High: The radio will transmit on its highest power level. 
  
Selectable: The radio can be switched between high and low power levels via the menu or function button. 

  
Transmit Code Guard: 

Analog and Mixed Mode channels can use sub-audible signaling to allow one radio or a group of radios to be 
selectively called within a system. 
CTCSS: Select the desired signaling tone via the drop down menu.(67.0 - 254.1hz) 
CDCSS: Select the desired signaling code via the drop down menu.(023 - 754) 
None: No Code Guard is transmitted. 

  
Receive Code Guard Index: 
When a Code Guard Index is selected, the channel will transmit the Code Guard from the associated picklist at initial 
power-up. 
If a new Code Guard is selected during radio operation, this field shows the currently selected Code Guard when the 
radio is read. 
  
NOTE: "Code Guard Index" must be checked in order to select this field. 
  
NAC: 
Each Digital or Mixed Mode channel is programmed with a transmit NAC. Range:0 – FFF 
The digital equivalent of carrier squelch is achieved by programming the receive NAC = F7E (3966 Decimal); the radio 
will unmute when a digital signal with any NAC is detected. 
  
NAC Index: 
When a NAC Index is selected, the channel will use the NAC from the associated picklist at initial power-up. 
If a new NAC is selected during radio operation, this field shows the currently selected NAC when the radio is read. 
  
NOTE: "NAC Index" must be checked in order to select this field. 
  
Invert DCS: 
Select to invert a DCS Code Guard. 
  
ANI Settings 

 
 
ANI Type: 
Specifies the format of the ANI (Automatic Number Identification) signal to be transmitted. 
  
ANI Index: 
This selection is used in conjunction with ANI Type, and specifies the content of the ANI signal. The index values are 
listed in the corresponding tab of the System Conventional page. 
  
ANI Mode: 
Specifies when the ANI code is transmitted. 
  
DTMF Live Dial: 
Enables the keypad to be used to transmit DTMF tones. 
  
Auto Keypad PTT: 
Allows user to initiate repeater calls through they keypad without first having to hold PTT. 
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Voice Mute 

 
Voice Mute Type: 
Voice Mute will unmute the receiver upon reception of the proper signal. 
  

Two-Tone: Receiver listens for the Two-Tone signal specified by the Voice Mute Index. The receiver is muted upon 
the activation of Voice Mute via menu or button. 
  
DTMF: Receiver listens for the DTMF signal specified by the Voice Mute Index. The receiver is muted upon the 
activation of Voice Mute via menu or button. 
  
Five-Tone: Receiver listens for the Five-Tone signal specified by the Voice Mute Index. The receiver is muted upon 
the activation of Voice Mute via menu or button. 
  
Voice Mute Type Auto: Selecting this checkbox will toggle the voice mute type to auto. 
  
Two-Tone Auto: Auto Receiver listens for the Two-Tone signal specified by the Voice Mute Index. The receiver is 
muted upon the selection of the channel. 
  
DTMF Auto: Auto Receiver listens for the DTMF signal specified by the Voice Mute Index. The receiver is muted 
upon the selection of the channel. 
  
Five-Tone Auto: Auto Receiver listens for the Five-Tone signal specified by the Voice Mute Index. The receiver is 
muted upon the selection of the channel. 

  
Voice Mute Index: 
This selection is used in conjunction with Voice Mute Type, and specifies the content of the Voice Mute signal. The 
index values are listed in the corresponding tab of the System Conventional page. 
  
  
Talkgroup 

 
 
Talk Group ID: 
Enter the desired talk group for the selected channel. 
Talk group ID's from 1 to 65535 are valid. 
  
Talk Group Index: 
When a Talk Group Index is selected, the channel will use the Talk Group from the associated picklist at initial power-
up. 
If a new Talk Group is selected during radio operation, this field shows the currently selected Talk Group when the 
radio is read. 
NOTE: "Talk Group" must be checked in order to select this field. 
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Reference 
  

 
  
A Reference Channel uses the settings of the channel specified. No other channel settings are allowed when this is 
checked, and all changes to the Reference Channel also change the channel referring to it. 
  
Zone: 
In conjunction with Reference Channel, specifies the Zone/Channel that will be used in place of the knob-selected 
channel. All changes to the Reference Zone and Channel will also affect this channel. 
  
Channel: 
In conjunction with Reference Zone, specifies the Zone/Channel that will be used in place of the knob-selected 
channel. All changes to the Reference Zone and Channel will also affect this channel. 
  
  
General 

 
Bandwidth: 
Determines the modulation level for the selected channel in analog mode. 
  

Wide: Selects Wide Band modulation. (25Khz channel spacing ) 
  
Narrow: Selects Narrow Band modulation. (12.5Khz channel spacing ) 
  
Hidden: 

Indicates that this channel cannot be selected from the keypad or menu, and is not on the list of channel selection 
choices. It can however be selected by the knob if it is one of the first sixteen channels. 
  
Surveillance: 
The Surveillance drop box allows this channel location to make use of the surveillance feature. 
  

Off: Surveillance mode is not enabled on this channel location. 
  
On: Surveillance mode is always enabled for this channel location. 
  
Selectable: Surveillance can be enabled/disabled on this channel location by using the menu or function button. 
  

Phone Patch: 
The Phone Patch option will be disabled unless Phone Patch Enable is checked for the System. 
  

Disabled: Phone patch is disabled for this channel. 
  
List Only: Phone patch may be invoked by selecting an entry from the Phone Number List. 
  
List and Keypad: The user may enter a number from the keypad to establish a call. 
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Channels - P25 Trunking  

Highlighting the desired P25 Trunking channel allows access the General tab. All P25 Trunking 
channel specific parameters are programmed on this tab. 
  

 
  
  
Channel Identification 
  

 
  
Alias: 
The radio can be programmed with a Label for each channel within a zone. 
Each label can include up to 13 characters. Characters can include A-Z, 0-9 or a blank space. 
The programmed Label will also display above the General tab when a channel is selected 
  
Talk Group Label: 
Enter the Label to be associated with the talk group assigned to the selected channel location. This 
Label will be displayed in the PTT-ID field when an active call from this talk group is received. 
  
Talk Group: 
The talk group to be associated with this channel location can be selected via the drop down 
menu. 
The talk groups appearing on this list have been entered in the "Talk Group" list. (System tab/P25 
Trunking, Talk Group List) 
  
Announcement Group: 
The announcement group to be associated with this channel location can be selected via the drop 
down menu. 
The announcement groups appearing on this list have been entered in the "Announcement Group" 
list. 
(System tab/P25 Trunking, Announcement Group list) 
  
Emergency Group: 
The emergency group to be associated with this channel location can be selected via the drop 
down menu. 
The emergency groups appearing on this list have been entered in the "Talk Group" list. (System 
tab/P25 Trunking, Talk Group list) 
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Scan 
  

 
  
Auto Scan: 
This feature will automatically start Priority Scan whenever this channel is selected. If Auto Scan is 
not enabled, scan is started via a function button or via the menu. 
  
Scan List Number: 
This setting determines which scan list will automatically be scan when the feature is active on a 
specific channel. 
  
  
Other 
  

 
  
Surveillance: 
The Surveillance drop box allows this channel location to make use of the surveillance feature. 

Off: Surveillance mode is not enabled on this channel location. 

On: Surveillance mode is always enabled for this channel location. 

Selectable: Surveillance can be enabled/disabled on this channel location by using the menu or 

function button. 

  
Dynamic Regrouping: 
Check to allow dynamic regrouping of the selected channel. 
  
DTMF ID: 
Used in conjunction with Voice Mute. Receiving these DTMF digits will cause voice mute to trip. 
  
DTMF Live Dial Enabled: 
Enables the keypad to be used to transmit DTMF tones. 
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Copy, Paste & Shortcuts  

Adding Channel 
Channels may be added to a zone by using the buttons at the bottom of the channel list, copy and paste from another 
channel, or using keyboard shortcuts. 
  
Shortcuts 
Add Channels 
To add a new conventional channel to the end of the channel list press Ctrl+N. 
To add a trunking channel press Ctrl+T. 
  
Delete Channels 
To delete a channel click the channel number field to highlight the channel then right click and press delete or click the 
-C button at the bottom of the table. 
All channels below the deleted channel will move up one position. 
  
Deleting Multiple Channels 
To delete consecutive channels, press the +/-C button and enter the range of channels to be deleted. 
  
  

 
  
For non-consecutive channels, enter the channels and ranges of channels separated by commas. 
For example, to delete channels 2 through 5, channels 9 through 12, and channel 14, type in 2-5,9-12,14 and hit 
delete. 
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Copy and Paste Channels 
To copy an channel, click the desired channel to highlight. 
Press Ctrl+C to copy. 
  
To select where to paste the copied channel, highlight a channel. 
Press Ctrl+V to paste the copied channel above the highlighted channel. 
  
NOTE: Copied channels can be pasted below the highlighted channel by right clicking and selecting Paste Below. 
  

 
  
Cut and Paste 
Cutting a channel will remove the channel from its current location and copy to the clipboard. 
Press Ctrl+X to cut a channel. 
Ctrl+V can be used to paste the channel in a new location as described above. 
  
Editing Zones 
To Add a zone, click the +Z Button. 
To Delete a zone, select the zone and click the -Z button. 
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Radio Options Control/Feature Editing Software 
 
Feature Editing Software  

A radio's currently installed options can be viewed by selecting Feature Editing Software from the Icon bar. 
The Feature Editing Software can also update a radio's current option configuration by obtaining an upgraded 
"Option" file from the factory. 
  

 
  
  
View the Factory Installed Options in a Radio 
Click the Read button to upload information from the radio. 
The embedded Electronic Serial Number (ESN) is displayed on the top line. 
Display and Version information is for factory reference. 
Checked options are currently installed. 
  
Hardware Options: 
Mobile High Power Enabled - 110 watt transmit power option for mobile radio. 
  
GPS Enabled - Global Positioning option for mobile radios. 
  
Continuous Channel Knob - Portable radio has continuous channel switch instead of sixteen position switch. (Portable 
CMD versions) 
  
Base Station - Indicates the radio is being used in a dispatch console environment and can limit the roaming 
capabilities. This can assist when the radio is to operate on a specific site. 
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The radio searches for a stable strong site. Once affiliated to that site, the radio will no longer attempt to roam unless 
the selected channel is no longer available. 
  
Bluetooth Enabled - Allows Bluetooth functionality. 
  
Encryption Enabled - Allows Encryption functionality. 
  
Three-way Priority Switch - Should be checked if the radio has a three-way priority switch. When programmed as a 
three-way switch, it becomes a zone-select switch. 
 
Conventional Options: 
Vote Scan Enabled - Allows vote scanning. 
  
Trunking Options: 
P25 Trunking Enabled - Allows programming of P25 systems and channels. 
  
Authentication - Enables Subscriber Unit Authentication Services for TDMA and FDMA trunking systems. 
  
Phase II Enabled - Allows the radio to operate on P25 Trunking systems that support TDMA. Suitable hardware is 
required for this mode of operation. 
  
Data Options: 
P25 OTAR Enabled - Allows over-the-air rekeying. 
  
OTAP Enabled - Allows over-the-air programming on P25 trunking systems. 
  
  
Installing Radio Options 
To install new radio options in the field a new options file must be provided by RELM Wireless Corporation. 
The file's embedded serial number must match the radio serial number. 
  
Open the provided file and click Write to update the radio options. 
 
 
FAQ 
 
FAQ  

Frequently Asked Questions 
  
File Saving 
A new conventional file can be saved without having a radio attached to RES. An ESN of all "0's" 
will be assigned to this file upon saving. 
New P25 Trunking files require the radio be attached and the appropriate system key be present 
before RES will allow the file to be saved. 
The same requirements apply if a P25 Trunking system is added to a new or archived 
conventional file. 
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